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SUPPORT AND CONTACT INFORMATION 

If you need help using TraumaCad, please contact our technical support group. Technical 

support is available by live online chat, email and phone. 

Visit www.traumacad.com and select Services Support for more details or to connect with a 

support representative online at www.traumacad.com/chat.html (during normal business 

hours). 

During your support session, you may be asked to provide information about your copy of 

TraumaCad. The Help menu displays the software version and access to support contact 

information. 

For a printed copy of the User's Guide contact Support by email to support@traumacad.com. 

 

Important Notice 

Copyright and Trademark Notices 

All contents of this document are Copyright 2022 Brainlab Ltd. 

All rights reserved. The trademarks, logos and service marks displayed on this document are the 

property of Brainlab Ltd or other third parties. Users are not permitted to use these trademarks, 

logos and service marks without the prior written consent of Brainlab Ltd, or such third parties 

as may own them. 

Limited License 

Brainlab Ltd hereby gives license to review these documents solely for non-commercial use 

within your organization, provided that you do not modify the content of the documents and 

provided any copies made retain all copyright and other proprietary notices contained therein. 

The information provided in these documents is permitted solely to users to provide 

information in support of Brainlab Ltd products. No other use of the information provided 

hereunder is authorized.  

Nothing contained herein shall be construed as conferring by implication, estoppel or otherwise 

any license or right under any patent or trademark of Brainlab Ltd or any third party. Except as 

expressly provided above, nothing contained herein shall be construed as conferring any license 

or right under any Brainlab Ltd or third party copyright. 

Limitation of Liability 

Information provided on this documents is provided "AS IS" and is provided without warranty of 

any kind, either express or implied, including, without limitation, warranties of merchantability, 

fitness for a particular purpose, and non-infringement. Brainlab Ltd uses reasonable efforts to 

include accurate and timely information on this web site and periodically updates the 

http://www.traumacad.com/
http://www.traumacad.com/chat.html
mailto:support@traumacad.com
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information without notice. However, Brainlab Ltd makes no warranties or representations as to 

the accuracy or completeness of such information, and Brainlab Ltd assumes no liability or 

responsibility for errors or omissions in the content of this documents. Your use of these 

documents is AT YOUR OWN RISK. Under no circumstances and under no legal theory or 

provision shall Brainlab Ltd be liable to you or any other person for any direct, indirect, special, 

incidental, exemplary, or consequential damages arising from your access to, or use of, these 

documents.  

Product information is subject to change without notice. Changes, if any, will be incorporated in 

new editions of publications provided in these documents. Brainlab Ltd retains the right to make 

improvements and/or changes in the products and/or the programs described in the 

publications and information provided on these documents at any time and without prior 

notice. Mention of non- Brainlab Ltd products or services is for information purposes only and 

constitutes neither an endorsement nor a recommendation of such products or services. 

Third-party Information 

These documents may contain information of parties other than Brainlab Ltd. Such information 

is provided for your convenience and reference only. The said information is not under the 

control of Brainlab Ltd, and Brainlab Ltd is not responsible for the contents of any of such 

information. The inclusion of this information does not imply any association with their 

operators or any endorsement of the said third parties by Brainlab Ltd. 

 Disclaimer 

This software is intended as a decision support system for persons who have received 

appropriate medical training, and should not be used as a sole basis for making clinical decisions 

pertaining to patient diagnosis, care, or management. All information derived from the software 

must be clinically reviewed regarding its plausibility before use in treating patients. Any 

deviation of the application of medical information from the program, other than the original 

design or intended use thereof, is not advised and considered a misuse of the software product. 

For additional guidance, see published studies. 

If any serious incident occurs in relation to the device it should be reported to the manufacturer, 

and if within Europe, to the competent authority of the Member State in which the user and/or 

patient is established. 
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SYMBOL GLOSSARY 

Symbol Standard 
Title 

FDA 
Standard 
Recognition 
Number 

Symbol Title Symbol 
Reference 
Number 

Explanatory Text 

 

ISO 15223-1 5-134 Unique Device 
Identifier 

5.7.10 Indicates a carrier that 
contains unique device 
identifier information  

  

ISO 15223-1 5-134 Medical Device 5.7.7 Indicates that the product is 
a medical device  

 

ISO 15223-1 5-134  Manufacturer 5.1.1 Indicates the medical device 
manufacturer 

 

ISO 15223-1 5-134 Importer  5.1.8 Indicates the entity 
importing the medical 
device into the locale 

 

ISO 15223-1  5-134 

  

Authorized 
representative 
in the European 
Community 

5.1.2 Indicates the Authorized 
representative in the 
European Community 

   Swiss 
Authorized 
Representative 

 Indicates the Authorized 
representative in 
Switzerland 

  
ISO 15223-1  5-134 

  

Consult 
instructions for 
use 

5.4.3 Indicates the need for the 
user to consult the 
instructions for use 

RX only  

  
Prescription 
Use only  

 
Caution: USA federal law 
restricts this device to sale 
by or on the order of a 
licensed healthcare 
practitioner 
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Safety Symbols 
The following symbols are used throughout the documentation. Please pay particular attention 

at specific points in a procedure when one of the following messages appears. 

 

Warning! denotes a hazard. It calls attention to a procedure that, if not 

correctly performed or adhered to could result in injury or loss of life. Do not 

proceed beyond a warning note until the indicated conditions are fully 

understood and met. 

 

 

Notes provide pertinent information to help obtain optimum performance 

from the application. 

 

 

Tips provide useful suggestions and information. 

 

 

Important! Denotes important information to which you should adhere. 
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AUDIENCE 

Intended Use: TraumaCad is indicated for assisting healthcare professionals in preoperative 

planning of orthopedic surgery. The device allows for overlaying of prosthesis templates on 

radiological images, and includes tools for performing measurements on the image and for 

positioning the template. Clinical judgments and experience are required to properly use the 

software. 

Intended users: this product is intended for healthcare professionals who want to perform pre-

operative surgical planning and evaluate medical images. 

Intended patient population: patient group of adults and pediatrics.  

Clinical benefits: the software helps healthcare professionals prepare in advance for orthopedic 

procedures, by evaluating the patient’s anatomy, by considering potential outcomes, and by 

choosing the appropriate implants.  

 

ABOUT THIS GUIDE 

This guide is intended for surgeons who are performing pre-operative evaluation and planning 

for orthopedic procedures. 

This guide contains the following chapters: 

• Getting Started with TraumaCad, page 14, describes the purpose of TraumaCad, its system 

requirements, how to install it, how to launch it and provides a quick tour through its 

interface. 

• Handling Images, page 34, describes how to use TraumaCad to load the required images, 

specify their anatomical orientation and calibrate the images. 

• Planning Your Surgery, page 51, describes how to use TraumaCad for pre-operative 

evaluation and planning for a variety of orthopedic procedures. 

• Measuring the Anatomy, page 70, describes how to use the various tools provided by 

TraumaCad to measure the anatomy represented in an image. It also describes how to take 

anatomical measurements, compare them to normative standards and simulate corrective 

procedures for limb alignment analysis. 

• Save Case:, page 21, describes how to generate a report. 

• Appendix A - Installing TraumaCad, page 172, describes how to install TraumaCad for 

standalone operation. 

• Appendix B - Standalone Usage, page 176, describes several procedures that may be 

required in standalone mode. 

• Appendix C - Managing Implant Templates, page 178, describes how to import and manage 

implant templates in the TraumaCad system. 
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GETTING STARTED WITH TRAUMACAD 
 

WHAT IS TRAUMACAD? 

TraumaCad allows surgeons to evaluate and manipulate digital images while performing various 

pre-operative surgical planning and evaluation of images. 

The program features full PACS integration and an extensive regularly updated library of digital 

templates from leading manufacturers. 

TraumaCad provides easy-to-use solutions for various orthopedic subspecialties: 

• Hip • Deformity 

• Knee • Trauma 

• Upper Limb  • Spine 

• Foot and Ankle • 3D Suite 

• Pediatric  
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TRAUMACAD WORKFLOW 

The following provides a chronological overview of the process of using TraumaCad. 

 

View the list of patients from your local cache, PACS or 

Quentry by clicking the applicable radio button at the 

top of the main view. See page 34 for details. 

Select the image you want to evaluate by clicking its 

thumbnail. To select multiple images, click the images 

you want successively, one after another. See page 41 

for details. 

Select the relevant surgical or analysis procedure to be 

performed to determine the specific templates and 

measurement tools that can be used in the application. 

See page 51 for details. 

Specifying the image orientation, view and side, and 

calibration are mandatory steps that must be 

performed for each image. See page 44 and page 44 

respectively for details. 

TraumaCad offers a large and easily accessible 

templates library together with a suite of orthopedic 

tools and wizards for measuring the actual anatomy in 

an image. 

A full report is generated, and can be stored together 

with the manipulated images in the patient’s PACS file, 

locally or uploaded to Quentry by saving the case. See 

page 22 for details. 

 

Warning! Be sure to save the patient’s case in order not to lose patient 

data. 

Finding a Patient 

Reporting and Saving 

Selecting the Procedure 

Defining the Image 

Performing Pre-operative 
Evaluation and Planning 

 

Selecting Patient Images 
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CLIENT/SERVER, STANDALONE OR TRAUMACAD WEB 

TraumaCad is installed and runs locally on your computer and interacts with a PACS system or 

Quentry. Three TraumaCad versions are available: client/server, standalone version and 

TraumaCad Web. 

 The TraumaCad client/server version consists of a server application that is set up by the 

administrator, and client applications that run on any computers. 

 The TraumaCad standalone version runs on a specific computer only and stores all its files, 

such as its configuration and implant templates. 

 TraumaCad Web is launched from Quentry, and is a cloud application that runs on any 

computer. 

These three types of applications operate in a very similar manner and there are only slight 

differences in functionality, as described below. 

 

Note: All TraumaCad versions can run through a Windows Mac virtual 

machine. TraumaCad Web runs automatically on a Mac through Citrix. 

 

 

Important! Some procedures and sections in the guide are marked to indicate 

whether they apply to standalone mode,  client/server mode or 

 TraumaCad Web mode. 
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TraumaCad Client/Server Functionality 

 Some features that are not available in the client/server version are performed by the 

administrator. Some of these administrator features apply to all the TraumaCad applications 

running in an organization, such as the library of implant templates, and some are user-specific 

according to the user that logs in to a client: 

• There is no need to specify the connection properties between TraumaCad and PACS. 

Therefore, the PACS Configuration option is not applicable in the client version. 

• The following are enabled/disabled for the clients by the administrator: 

• Import Image  

• Import DICOM Folder  

• Query  

• Download Templates  

• Screen Capture  

• Save to Local Folder  

TraumaCad Web and Standalone Functionality 

  All the functionality described in this guide is available in the TraumaCad Web 

version and the standalone version. 

Automatic Updates and Upgrades 

 For the client/server version, the application is upgraded in the server only and from there 

distributed automatically to the clients. Before the TraumaCad client starts, it automatically 

updates itself and then starts in a normal fashion. 

Template updates for the client/server version are done automatically via the web. 

 For TraumaCad Web, the user’s TraumaCad version automatically upgrades/updates to 

reflect any updates made to the application. 

 For the standalone version, if there is an update to the application, a message is presented 

to the user, offering the option to update the TraumaCad application. The user can select either 

Yes or No at that point. When selecting No, the user can perform updates later by selecting 

Help  Check for Update in the menu bar. 



Getting Started with TraumaCad 
 

 18 

SYSTEM REQUIREMENTS 

Hardware and Software 
TraumaCad is a Windows based product. For more information on supported operating systems 

and TraumaCad server and client prerequisites, click here. 

Security Measures 
IT security measures, including protection against unauthorized access, are taken to run the 

software as intended:  

• Authentication and authorization processes, including session timeout mechanism. 

• Audit logs of the key actions in the system. 

• Master key based data encryption mechanisms. 

• MS Security Patches are verified for compatibility with software on a regular basis. 

• HTTPS SSL network security for client-server data transfers available. Specific ports are open 

for client server communication (note: additional customer certificate is required) 

For additional information, contact Brainlab support. 

Clinical Requirements 
To perform accurate templating, the image should be calibrated. Image requirements may differ 

according to the image source: 

• Uncalibrated Images: A calibration device must be placed prior to taking the image in order to 

secure accurate measurements and implant sizing. 

• DICOM Images with a Preset Calibration Attribute Acquired from the Modality: Calibration 

can be approximated by oversize estimation, however, using a calibration device is 

recommended for better accuracy.  

For more information on image calibration and calibration devices see page 44. 

Combination with Other Devices 
TraumaCad can be used in combination with Brainlab Quentry cloud service and various PACS 

systems. 

  

https://www.traumacad.com/support/Release/TraumaCad/2.5/Prerequisites/TraumaCad%202.5%20Requirements.pdf
mailto:traumacad.support@brainlab.com?subject=TraumaCad%20Security%20Measures
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LAUNCHING TRAUMACAD 

 To launch TraumaCad: 

1. Double-click the TraumaCad icon that was installed on your desktop: 

  

If this is not the first time that TraumaCad is launched on this computer, the main window is 

displayed, as shown on page 20. 

 For first time activation, enter the required activation information provided by Brainlab. 

For online activation using an activation key, you must be connected to the internet. Select the 

Enter Activation Key radio button, enter a valid activation key and click Activate. 

For offline activation using a license file, you do not require connection to the internet. Select 

the Install License File radio button and click on the Browse button to select the License file. 

Then click Activate. 

 

2. After entering a valid activation key or a license file, the Activate button becomes active. Enter 

information about yourself in the displayed window and click OK. 

TraumaCad application is opened and you can get started planning. 
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QUICK TOUR OF THE TRAUMACAD INTERFACE 

This section provides a brief overview of the features of the TraumaCad application, and describes 

its main window, menu bar and toolbar. The main window displays a list of patients and their 

images. It also serves as the main work area in which you can measure anatomy, select an 

appropriate implant or plan for an operation. 

 

 

Note: After you select an image(s), the interface displays as shown on page 52, 

where you select the procedure to be performed. 

This section describes the following: 

• Menu Bar, page 21 

• Toolbar, page 28 

• TraumaCad Right-click Menus, page 29 

• Touch Screen Interface, page 30 

 

Note: Status Bar: Indicates the status of the application. 

 

 

Tip: All TraumaCad options are accessible from both the toolbar and the menu 

bar. 

Menu Options 

Patient List 

Toolbar 

Image Preview 

Le
ft

 P
an

el
 M

ain
 V

iew
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Menu Bar 
The following describes the menu options available in the TraumaCad menu bar. 

File Menu 

 
 

• New Case: When you launch TraumaCad, a new case study is opened. Only one case can be 

open at a time. Opening a new case closes the current case and removes all the displayed 

images. Before starting a new case, make sure to save the current one. 

• Open Case: Opens a local case that was stored on your computer in a folder called My 

TraumaCad Cases or on a memory stick. Locally stored cases have a file extension of .tcc. See 

page 40 for details. 

• Save Case: Saving a case enables you to store all its images, templates, measurements and 

case information and later re-open it in TraumaCad. This option opens a window in which you 

can select to save this case by choosing any of the following options:   
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• Quentry: Uploads the case to Quentry. Use the Login option to log in to Quentry, if you are 

not already logged in. 

 Use JPEG Lossy Compression: When this option is selected, the DICOM files in the *.tcc 

file sent to Quentry are compressed using JPEG Lossy compression. 

 Select contact: You can choose which account to upload the files to: 

- Your own account 

- The account of a contact or Care Team that has given you permissions to upload 

• PACS: Commit the case to PACS. 

 Including Report: When this option is selected, images are converted from HTML 

format to DICOM images for inclusion in reports. HTML cannot be committed to PACS. 

• Local Folder: Saves the case locally in the My TraumaCad Cases folder or any other desired 

location, including memory stick. You can change the Case Default Location of the local 

folder using File menu  Settings  Save Case. 

• Annotation: Selects the positioning and orientation of the text on the saved image. 

• Download Templates: Downloads templates of implants from Brainlab Ltd.’s global repository 

to your computer. 

• Search for Images: Searches for and adds an image while performing a procedure. 

• Change Procedure: Changes the surgical or analysis procedure for a given patient after your 

initial procedure selection for this patient. See page 52. 
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• Import Image: Imports a single image file. See page 36. 

• Import DICOM Folder: Imports a folder of DICOM images to your local cache. See page 36. 

• Export to DICOM Folder: Saves the DICOM image on the local PC as a DICOM folder. 

• Export to Excel: Exports the measurements to an Excel sheet. This option is especially suited 

for research, as each measurement is added as a row in the Excel sheet file that you specify. 

• Delete Cache: Clears the cache of images on your local computer. 

• Screen Capture: Captures any image that is displayed on the screen into TraumaCad. See 

page 37. 

• Settings: Defines settings for the TraumaCad application. See page 33. 

• PACS Configuration: Configures the connection properties between TraumaCad and the PACS 

system. See page 177. 

• Language: Chooses the language for displaying the TraumaCad interface. 

• Exit: Closes the application. 
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Image Menu 

 

• Rot. 90° CW (clockwise): Rotates the image 90° clockwise. 

• Rot. 90° CCW (counter-clockwise): Rotates the image 90° counter-clockwise. 

• Rot. 180°: Rotates the image 180°. 

• Vertical Flip: Flips the image vertically. 

• Horizontal Flip: Flips the image horizontally. 

• Invert Image: Reverses the areas of black/white on the image. 

• Group: Groups multiple objects on the image to handle them together as a single object. See 

page 32 for details. 

• UnGroup: Removes objects from a group. 

• Copy to Clipboard: Copies the displayed image to the clipboard, including the implants, textual 

annotations and measurement tools that were added. 
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Basic Tools Menu 

 

• Move: Moves an object in the image by dragging the mouse. Click this tool, click an object that 

was drawn on the image, hold down the mouse button and then move the mouse to move the 

object. 

• Pan: Moves the image itself. Click this tool, click the image and hold down the mouse button. 

Then, move the mouse to move the image. You can also use the mouse wheel to pan the 

image by simply holding the wheel down and then moving the mouse to move the image. 

• Zoom: Zooms in (enlarges) or zooms out (shrinks) the image view. Click this tool, click the 

image, hold down the mouse button and then drag the mouse up to zoom in or down to zoom 

out. You can also use the mouse wheel to zoom by rolling it upwards to zoom in and 

downwards to zoom out. 

• Window Level: Enhances the visible distinction between contrasting tissue regions by 

manipulating the brightness and contrast. Position the cursor on the image, and click this tool. 

Then, click the image and drag the mouse left or right to change the contrast, and up or down 

to change the brightness. 

• Restore Original W/L: Returns the image’s contrast and brightness settings to their original 

values. 

• Fragments Submenu: See pages 61 through 62 for more details. 
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Measurement Tools Menu 

 

• Text Annotation: Adds a textual annotation to be shown on the image. 

• Basic Measurements Submenu: See pages 70 through 74 for details. 

• Hip Submenu: See page 75 for details. 

• Knee Submenu: See page 89 for details. 

• Pediatric Submenu: See page 100 for details. 

• Trauma Submenu: See page 128 for details. 

• Spine Submenu: See page 132 for details. 

• Foot and Ankle Submenu: See page 149 for details. 

• CORA Tools Submenu: See page 161 for details. 

• Launch Growth Calculator: Opens the Growth Calculator. See page 162 for details. 
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Window Menu 

 

• Fit to Screen: Returns to the original image size after zooming in. 

• Layout: Specifies the layout of more than one image on the screen. 

• Magnifying Glass: Displays an enlarged view of the area around the mouse cursor in a 

separate window. Magnification can be adjusted as needed. 

• Navigation Window: Used to navigate on a zoomed in image. Drag the green box to select the 

specific area of the image to be displayed in the main area. 

Help Menu 

 

• Go Online: Displays Brainlab’s website. 

• Check for Update: Checks if there is an update available for the application. 

• Request a Template: Accesses the Brainlab website to request a template. 

• User Guide: Displays the online help of this User’s Guide. 

• Quick Start Guide: Opens a quick help guide to get started with the TraumaCad workflow 

• About: Presents license and version information for TraumaCad. 
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Toolbar 
The following provides a brief description of each of the tools in the TraumaCad toolbar.  

 

 Search for Images: Searches for patient images. 

 New Case: Opens a new case study. 

 Change Procedure: Changes the procedure selected for planning. 

 
Open Case: Opens a saved case. 

 
Save Case: Saves an open case. 

 
Move: Move an object. 

 
Pan: Pans around the image. 

 
Zoom: Zooms in or out in the image. 

 
Window Level: Enhances the visible distinction between contrasting tissue regions 
by manipulating the brightness and contrast. 

 Fit to Screen: Fits an image to the width of the screen. 

  Undo and Redo: Undoes and redoes the last action in TraumaCad. 

 
Ruler: Measures a section of the image. See page 71 for details. 

 Circle: Measures the diameter of any round object. See page 71 for details. 

 
Angle: Measures an angle. See page 71 for details. 

 
Interline Angle: Measures the angle between two lines on an image. See page 71 
for details. 

 Line: Draws a line on an image. See page 72 for details. 

 
Free Hand Line: Enables you to draw a freehand line on the image. See page 72 for 
details. 

 
Arrow Tool: Draws an arrow to indicate an area on the image for further attention. 
See page 72 for details. 
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Text Annotation: Adds a textual annotation to be shown on the image. See 
page 72 for details. 

 Delete Selected Object: Deletes a selected measurement tool or implant that you 
have added onto the image using. 

 
Copy implant: Duplicates a selected implant. 

 
Flip Implant/Fragment: Flips the selected implant or fragment left or right. 

 
Define Fragment: Draws an outline around a fragment. See page 60 for details. 

TraumaCad Right-click Menus 
The right-click menus vary, depending on the type of object selected. The following figures show 

examples of the menus that display when selecting measurements, templates and images, 

respectively. 

    

 Measurements Right-click Menu  Templates Right-click Menu Images Right-click menu 

 

 

Note: The Color option is available on the templates and measurements right-click 

menus. This option enables you to change the color of the template/ measurement 

tool.  
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Touch Screen Interface 
To enable TraumaCad touch mode, go to File  Settings  Touch Mode.  

System Requirements 

Touch screen is supported for Windows 7 and up. 

Touch Screen Toolbar 

The touch screen toolbar is similar to the TraumaCad toolbar with larger buttons to facilitate 

touch. For more information on each tool in the toolbar see Toolbar on page 28. 

Touch Screen Functionality 

• Use a 2 finger pinch to zoom in or zoom out on an image. 

• Swipe right or left to pan an image. 

Swipe up or down to scroll templates, measurements lists or any other objects: 

• A virtual keyboard opens automatically (partially hidden) on the far left side of the screen 

when typing text is available. Drag the keyboard onto the screen to type. If the keyboard is 

hidden, contact your system administrator. 

 

Note: It is not possible to work with mouse and keyboard when planning in 

Touch Mode. 

 

Right-click Menus: 

• The right-click menu appears as a button  on the image. Touch the button to open the 

right-click menu. 
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• For multi-selection of objects, touch Multi Selection on the toolbar and then touch the right-

click menu button. The multi-selection right-click menu appears. 

 

 

• Right-click on a fragment for the following menu: 
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Grouping Objects 
TraumaCad enables you to group various types of objects together into a group, including 

measurements, fragments and templates. Once grouped, the objects comprising the group can be 

moved and rotated as a single object. 

TraumaCad also provides special options for grouping templates. See page 63 for more details. 

 To group TraumaCad objects: 

1. Using your mouse, hold down the mouse button and draw a selection box around the objects 

to be grouped. A yellow bounding box surrounds the objects you selected. Alternatively, you 

can select multiple objects while holding down the Shift key. 

 

2. Right-click one of the objects within the bounding box and select Group. The objects are now 

grouped and can be moved and rotated as a single object. To rotate the group, click the 

handle at the top of the bounding box and pull in the direction in which you want to rotate the 

group. 

Grouped items remain grouped until you ungroup them by using the right-click menu or the 

Image menu. 

Handle 

Group Bounding Box 
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TraumaCad Settings 
The Settings window enables you to configure various settings used by the TraumaCad application. 

Select File  Settings to open the Settings window: 

 

This window contains the following branches: 

• Planning: Defines automatic features defaults for hip and knee planning. Define the femoral 

and tibial cut level and side, as well as the femoral anatomic angle. 

• Implants: Defines the colors and anchor size for implants. Enable a floating implant property 

window. 

• Measurement Tools: Defines the colors, width and size of the anchors and lines of the 

measurement tools, and enables black and white mode. 

• Fragments: Defines the colors and anchor size for fragments. 

• Text: Defines the saved images text annotation, including fonts size and color as well as 

background color and opacity. 

• 3D Mode: Defines the colors, anchor sizes and lines for 3D tools. 

• Report: Enables you to include a logo that is displayed on reports. 

• Save Case: Specifies the default location for storing cases, which information to display, as 

well as where text annotations should be positioned on the planned images. 

 



 

 34 

HANDLING IMAGES 

TraumaCad supports DICOM and enables you to import (and export) any PACS file 

(X-ray, CT or MR) from a central PACS system, a CD or from a local workstation.  

JPG, scanner or digital camera images can also be imported, and any image can be captured 

from the screen and used in TraumaCad. 

The following options are provided for importing images:  

• Importing Images, page 36 

• Capturing Images From the Screen, page 37 

• Quentry Patient Folders, page 37 

FINDING THE PATIENT 

TraumaCad provides a variety of options for finding a specific patient of interest. 

TraumaCad is transparently integrated with the PACS and enables full access to its patient 

images. If TraumaCad is integrated into your PACS, then all you need to do to access an image is 

to display it in the PACS, and then select the TraumaCad option. 

 

Warning! When importing an image from the PACS system, make sure that you 

import data from the correct patient, and use the correct image from the correct 

patient. 

 To find a patient: 

1. Perform any one of the following: 

• Enter/select all or some of the patient’s information in the Patient ID, Patient Name and 

Accession fields. You can also enter part of the patient’s ID or name. 

• From the Modality dropdown, select the modality type of the system. The default 

modalities selected for search are CR, DX/DR. Note that OT refers to TraumaCad cases 

that were stored in PACS. These cases include the original study and therefore the query 

results will also include CR image even if CR was not selected for the search. 

• From the Date dropdown, select Today, Yesterday, Last 7 Days, Last 14 Days, Last 30 

Days or All option to see all the images within this date range. 

2. Click Query. 

3. Click Reset to clear the fields previously entered. 
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Typically, the search results list is sorted by Last Name, then First Name and then Study Date. 

You can scroll down in this list or sort the listed patients by clicking the dropdown arrow for a 

column (at the top of the list), and then selecting the sort criterion to be used. 
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IMPORTING IMAGES 

• Import DICOM Folder: Imports a folder of DICOM images to your local cache. To use this 

option, select the Import DICOM Folder option in the File menu. This action opens a window 

in which you select the folder containing the images to be imported. 

• Import Image: Imports a single image file that is a JPG, PNG or BMP format. To use this 

option, select the Import Image option in the File menu. A window is displayed in which you 

can enter the patient and study information relevant for this image that will be stored with 

it. When completed click the Import Image button to browse for an image. 

 

 

Warning! When importing an image or using an image from the local cache, make 

sure that you import data from the correct patient, and use the correct image from 

the correct patient. 

When importing an image, the progress of the import is displayed in the Status Bar, as shown 

below: 

 

 

Note: Select File  Delete Cache to clear the cache of images on your local 

computer. 
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CAPTURING IMAGES FROM THE SCREEN 

Select the Screen Capture option in the File menu to capture any image that is displayed on the 

screen into TraumaCad. The following window is displayed: 

 

Drag the Finder Tool  over the image to be captured. It is then added to TraumaCad, and 

you can later commit it to PACS if you like. 

QUENTRY PATIENT FOLDERS 

Quentry is a web-based environment where the medical staff can upload and store their patient 

folders in a highly secured location. 

Doctors can manage patient folders including images, attachments and any other files into a 

private account and share them with their colleagues online. 

Login to Quentry 

 To login to Quentry: 

1. Select the Quentry radio button on the main screen to access the patient data that you 

saved in Quentry, as shown below: 
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2. Click the Click here to login to Quentry link. 

The login window is displayed; fill in your Brainlab ID and password as provided to you by 

Brainlab’s team. 

 

Selecting Patient Folders 

 To select patient folders: 

1. Select the Quentry radio button on the main screen to access the patient data that you 

uploaded to Quentry.  
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2. If there is more than one study, click the patient row to expand the studies and select the 

check box to open. 

 

3. Click the Open Selected button on the right.  
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Local Cases 

To open the cases that you saved locally on your computer or on a memory stick in a folder 

called My TraumaCad Cases, click Open Case  on the toolbar. The following window opens 

in which you select the case to open. 

 

The My TraumaCad Cases folder contains a sub-folder for each case that it contains: 

 

The following describes the sub-folders provided for each case: 

• Original Images folder: Contains the original images, in *.jpg format.  

• Templated Images folder: Contains the templated images, in *.jpg format.  

• TraumaCad Case (tcc): This file is the locally stored case with the file extension of *.tcc. The 

file is encrypted and can be read only by TraumaCad. This file type is associated in Windows 

with TraumaCad and automatically opens in the TraumaCad interface. 

• HTML Report: A report is created automatically for each case. It provides a summary of the 

planning. For more details see Generating Reports. When saving a case to a local folder or 

Quentry, the report is also saved in a PDF format.  
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Note: Select File  Delete Cache to clear the cache of images on your local 

computer. 

SELECTING THE PATIENT’S IMAGES 

Once you have found the patient in which you are interested, you can select the relevant 

images, an entire series or an entire study to be viewed. Double-click the relevant row, or click 

the plus sign  to drill down and see the series in a study and then again to see the images in a 

series. Double-click the study or the image to retrieve it from PACS and display it in the 

TraumaCad window. 

The following diagram shows how to drill down and select a specific image in a series of a study. 

 

 

 

 

 

Note: Typically you select an entire study for a patient. 

 To select patient images: 

1. Double-click the study or the image to retrieve it from PACS and display it in the TraumaCad 

window. 

Once images are retrieved from the PACS or from any other location, they appear on the 

sidebar on the left panel. 

1. Click on a study to display 
the series that it contains. 

2. Click on the series + 
button to display the 
images that it 
contains. 

3. Double- click on an image to select it.  
A thumbnail of this image is displayed. 
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2. Click on the images you want to work with to select them. The selected images are displayed 

in the main view. 

3. After selecting the images, click Next at the bottom of the left panel to move to the 

procedure selection phase. 
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MULTIPLE VIEWS 

Up to four images can be displayed simultaneously in the main work area. The active image has 

a red border. An unlimited number of image thumbnails can be displayed in the sidebar on the 

left of the window. 

To make an image the active image, click the image in the main work area. 

 

Double-click an image to select it for a single view. Double-click again to shift back to the 

multiple views. 

Red border 
indicating active image 

Active image 
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DEFINING AN IMAGE 

Once the images are selected and the procedure is determined, TraumaCad working area is 

displayed. The Image tab is opened by default to define the image orientation and calibration. 

As these steps are mandatory for all selected images, all other tabs are disabled until all steps 

are completed: 

• Specifying Image Orientation and Body Side, below  

• Calibrating the Image, page 44 

Specifying Image Orientation and Body Side 

 To specify image orientation and the patient’s body side: 

  

1. Select the AP or LAT radio button to specify the applicable image view. 

2. Select the Right or Left radio button to specify body side. 

3. Calibrate the image, as described in Calibrating the Image on page 44. 

4. Click Accept. 

5. If there is more than one image, after the first one is defined the second one is 

automatically selected. Repeat steps 1 through 4 for that image.  

Calibrating the Image 
Direct linear measurements cannot be taken from plain X-rays because of the unknown 

magnification factor inherent in the X-ray-taking process. 

There are two ways of determining the magnification factor: 

• To know the distance from the source of the X-rays to the object and the distance from the 

source to the X-ray plate. 

• To include an object of known size or a radio opaque ruler in the plane of interest. 
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Warning! X-ray images can display with incorrect bone measurements due to the 

wrong angle of the bone during X-ray acquisition. Make sure to take X-rays with the 

bone at the correct angle. 

Automatically Calibrate an Image 

 To automatically calibrate an image: 

Automatic image calibration is performed in the Calibration area of the Image tab, as shown 

below: 

 

Automatic calibration attempts to find a marking device when opening the image. The 

marking device is then used to calibrate the image. Recommended devices are KingMark, 

and VoyantMark, for further details see page 48. This is the default calibration method. 

When a metal ball marking device is detected the message “Metal calibration ball detected 

where shown” is displayed in the Image tab and a circle appears on the image, indicating 

where the marker was found. By default the ball size is 25.4 mm (1”). This size can be 

changed by setting a new size in the Metal ball size text box in the Image tab. 

When a KingMark device is detected the message “KingMark calibration device 

automatically detected” is displayed in the Image tab. 

 

If this is correct, click Accept. 
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When a marking device is not detected the message “No calibration device has been 

detected. Please select another calibration method” is displayed in the Image tab: 

  

In this case, you must calibrate the image using the Manual or Oversize options, as 

described on pages 46 and 47, respectively. 

For automatic calibration using a circle marker that appears in the image but has not been 

detected, you can click Select another point and then click inside the marker on the image 

to detect the entire spherical marker.  

Manually Indicating the Marker in the Image 

 To manually indicate the position of the marker: 

1. Click Manual.  

2. Select the calibration method you wish to use: Ruler or Circle. 

 

3. Draw the measurement on the image. 

4. When the line/circle exactly covers the extent of the marker in the image, click Accept. 
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Using the Oversize Option 
The Oversize option enables you to scale up an image from its original size.  

To resize an image, click the Oversize button and then enter the resizing percentage in the text 

box. It is possible to scale an image up or down from its original size. When ready, click Accept. 

 

 

 

Note: If no calibration data is available in the DICOM image, for example, if the 

image is a jpeg, then the Oversize option cannot be used. 

At the end of the calibration process, click Accept to accept the calibration. The calibration 

status of the image is indicated on the image, as shown below: 

 

If there is no calibration data in the image when performing automatic or manual calibration, 

then the image indicates the DPI value as part of its calibration status, as shown below: 

 

 

Note: If the Remove Marker after calibration option is checked in the Calibration 

section, then the measurements on the marker are removed after calibration and 

the marker appears as it was before calibration.  

You can return to the Image tab at any time and recalibrate an image. 
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Ball-Marker 
A 1-inch (25.4 mm) is the exact size from all 
angles and is positioned at the same plane as 
the bone of interest 

VoyantMark – Calibration Sphere 
Brainlab’s spherical metal X-ray marker scaling device is intended to provide a scale for plain 

X-rays. The scaling sphere should be placed at the bone height. The bone and sphere should 

then be the same distance from the X-ray plate and the X-ray source. 

 

 

When an X-ray image is scaled using a ruler or simple object, it is impossible to verify whether 

the scale was placed in the correct plane at the time of acquisition. The advantage of the sphere 

is that it is three-dimensional and its diameter is constant from any angle that the X-ray is taken. 

 

Note: Measurements performed on uncalibrated images are in pixel units, while in 

calibrated images they are in millimeters. 

  

 

Tip: To enable automatic calibration, you can use VoyantMark or KingMark. 

Contact your Brainlab sales representative if you need to obtain them. 

Positioning the marker 

Distance from film plane to bone level 

Detector plane 
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KingMark 
KingMark is a double marking device comprised of two separate markers—one is placed behind 

the pelvis and the other in front, as the patient lies supine. The anterior marker is a flexible strap 

that secures radio-opaque balls at regular intervals. The posterior marker is a radiolucent pad 

with steel rods embedded in a vertical row. 

 

TraumaCad automatically detects the presence of KingMark in an X-ray, determines the 

magnification percentage and sizes the image accurately.  

 

One of the five balls should align with the femoral head of the hip and the rods should run 

midline through the pelvis. If the markers are very off center and not positioned between the 

hips, the X-ray should be repeated. 

Strap holds the ball-strip 
to the front of the patient 

Base is position under hips 
as patient lies supine on 
the x-ray table. Base 
contains radio-opaque 
rods. 

Ball-strip contains 5 
radio-opaque balls. 

Weight helps keep 
ball=strip and strap snug 
to the patient’s body. 
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Follow the tips below when working with the KingMark device: 

• The positioning technique remains the same for all sizes of patients. Since KingMark is 

positioned midline, it always appears within the radiograph—even on very large patients. 

• Flatten or remove bulky clothing that keeps the ballstrip from fitting snuggly to the patient. 

• Attempt to have each ball in the ballstrip touch the patient—or be as close as possible to the 

skin. However, do not pull the strap and ballstrip so tight that it significantly compresses the 

patient’s skin or adipose tissue. 
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PLANNING YOUR SURGERY 
When planning your surgery first select the appropriate procedure. The relevant measurements 

and templates library are available according to the selected procedure. 

Once images are selected and a procedure is determined, you are ready to start planning.  

The TraumaCad planning window consists of a series of tabs on the left panel and the main area 

on the right that displays the image(s). 

The following tabs are shown in the left panel: 

• Image: Used to define image orientation and calibration. See page 44 for details. 

• Templates: Apply templates to the image. See page 53 for more details.  

• Measurements: Displays a variety of tools and wizards relevant to the selected procedure. 

For more information, see page 70. 

• Report: Generates reports, previews planning and Save the Case. See page 170 for details. 

 

The following options are available for planning your surgery: 
• Procedures, page 52 

• Templating, page 53 

• Trauma Procedures, page 59 

• 3D Suite (Optional), page 67 

• Measuring the Anatomy, page 70 

 

Left Panel 
Main 
View 
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PROCEDURES  

The TraumaCad application is procedure-oriented. This means that you must select the relevant 

surgical or analysis procedure to be performed on the patient. Only the relevant templates and 

measurements for the procedure chosen are displayed. 

Click the icon corresponding to the surgical or analysis procedure to be performed. 

 

After you select a procedure, the patient’s image is opened in the TraumaCad main window. 

At any point you may change the procedure by selecting the Change Procedure icon  from 

the toolbar. Note, that changing the procedure will result in clearing any measurements and 

planning that were made so far. 



Planning Your Surgery 

 53 

TEMPLATING 

TraumaCad optimizes templating for complex reconstructions and osteotomies, as well as for 

standard primary replacements. TraumaCad offers a large and easily accessible template library. 

This library is constantly updated automatically through the server or manually in the 

standalone version. 

Refer to the following sections for a description of the main steps of these procedures: 

• Selecting an Implant, page 53 

• Positioning a Template, page 55 

• Specifying Implant Properties, page 56 

• Building a Kit and Favorites Lists, page 57 

• Special Trauma Template Features, page 63 

Selecting an Implant 
The templating process for each of the procedures (hip, knee, upper limb, pediatric, deformity, 

trauma, spine and foot and ankle) is similar. Of course, the implant library differs for different 

anatomical regions. A window such as the following is shown when you select templates: 
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The process of identifying the required implant is also referred to as templating. During this 

process, you select the appropriate implant from the available inventory, position it on the 

image on the appropriate anatomy and adjust the size and a variety of other properties. 

Four sub-tabs are displayed under the Templates tab, as follows: 

• Implants: Displays a list of templates search results. See page 53 for details. 

• Kits: Enables you to define your own kits of templates that you can add to an image 

together. See page 57 for details. 

• Recently Used: Lists the last 20 templates used in this procedure. 

• Favorites: Saves templates to a favorites list. 

 

Note: If the templates library is empty, the window contains a button, as shown 

below: 

 
Click the Download Templates button to download the required template. For 

more information, see page 180. 

 To select the appropriate implant(s): 

1. In the Templates tab, select the manufacturer of the implant from the Manufacturer field. 

Selecting a manufacturer determines the types of implants that are available for selection in 

the Type of Implant field. 

2. Select the type of the implant in the Type of Implant field. 

3. [Optional] You can search for a specific template using the Look for field. 

 

Enter your search text in the Look for text box and click . This search function is 

procedure-specific, meaning the results are filtered according to the selected procedure. 

When you use this search option, you can leave the Manufacturer and Type of Implant 

fields blank. Otherwise, the search is filtered according to the fields (Manufacturer or 

Template Type). 

To specify that the search is not procedure-specific, check the Search the entire Templates 

Library checkbox. 

Click the Look for dropdown arrow  to display a history of past searches. 
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4. Select an implant from the Implants list. Double-click the implant’s name or drag and drop it 

from the list onto the image. 

5. To add another template to the image, click Add Template from the left panel and simply 

find the implant you want and place it on the image as described in Specifying Implant 

Properties on page 56. 

Positioning a Template 
You should position the implant on the image according to surgical considerations. A number of 

options are provided to facilitate implant positioning on the image. 

 To move an implant: 

• Click the implant to drag and drop it to the required position. Alternatively, you can 

select the Move  tool and then use the arrow keys to move the implant in small 

increments. 

 To rotate an implant: 

• The selected implant is indicated by a yellow border with a rotation handle. 

 

              

• Click the rotation handle and move it left or right to the correct degree. Selected cups 

display the cup inclination angle. 

• You can also flip an implant using the Flip Implant  tool, and change it from AP to 

LAT and vice versa by using the Transpose View  tool from the implant right-click 

menu. 

The selected implant automatically appears in the new orientation.   

Rotation Handle 

Hinge 
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Specifying Implant Properties 
Once the template is selected, you can specify more properties of the implant, such as its size, 

offset and number of attachments. 

 To specify implant properties: 

 

1. In the left panel, the implant properties can be adjusted. Specify the properties of the 

implant to suit the surgical procedure, for example: 

• The size of the implant in the Size field. 

• The length of the implant in the Length field. 

• The lateral offset of the femoral head in the Offset field. 

• The neck length of the implant attachments in the Attachments field. 

These properties and more differ according to the selected implant. 

You may find it useful to lock an implant’s properties. Properties in TraumaCad are 

synchronized by default. This means that locking a property on a specific value automatically 

displays the values of other properties that match the locked value. 

To lock a property, double-click the property in the property list. Double-click the property 

value again to unlock this property. The figures below show examples when the Offset 

property is locked and unlocked. 
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Locked Properties Unlocked Properties 

2. To delete an implant from the image, simply select it and press the Delete key or the Delete 

Selected Object  tool. 

 

Note: In Settings  Implants you can choose to float the implant properties 

on the image.  

Building a Kit and Favorites Lists 

 To build a kit: 

1. Add the preferred cup template and stem template to an image. 

2. Drag the cursor around them to select them both. 

3. Right-click this selection and select the Create a Kit option from the menu, as shown below: 
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The following window is displayed: 

 

4. Enter a name and description for this kit and click OK. This new kit then appears in the Kits 

tab, as shown below: 

 

You can hover over this kit to display information about the templates that it comprises. 

5. To add this kit to the image, simply double-click on it in the Kits tab. All the templates in the 

kit are then added to the image. 

 

Tip: To remove a template kit, select it on the image and use Delete function 

on the keyboard. 

To remove a kit from the kits list, select the kit on the image and press Delete 

on the keyboard. 

 To save an implant in the Favorites tab: 

• Select an implant from the implants list. While holding down the mouse button, drag and 

drop the implant onto the Favorites tab. 
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TRAUMA PROCEDURES 

TraumaCad is designed to meet the needs of the trauma environment. TraumaCad enables you 

to define fracture or bone fragments, and to move, rotate and copy fragments on the image to 

reconstruct on the healthy side and accurately restore the anatomy on images prior to 

templating. 

• Specifying the Anatomical Region (for a trauma procedure), page 59. 

• Working with Bone Fragments, page 60. You may try different options for reducing the 

fragments and then select the optimal one. 

• Special Trauma Template Features, page 63. Some TraumaCad trauma templates have 

special features not available with other templates, such as the ability to bend plate 

templates at marked points and determine screw type properties. 

Specifying the Anatomical Region 
For some procedures, you specify the anatomical region for the procedure. This option does not 

appear for all procedures. 

 To specify an anatomical region of the body: 

1. Move the mouse over each relevant area of the body on the skeletal image on the left. As 

you do so, it is highlighted in red. This action filters out templates that do not apply for this 

region. 
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2. Click the relevant part of the body to access the Templates, Measurement Tools and Report 

tabs. 

 

Note: Click the Skip Anatomical Region Selection button to disable template 

filtering. 

Working with Bone Fragments 
You can define fragments when planning a bone reduction procedure or an osteotomy. Several 

tools and menu options are provided to define and affect the bone fragments in the image: 

Define Fragment , Lasso Tool (select Menu Bar  Basic Tools  Fragments  Define 

Fragment) and Duplicate Fragment  (access from the right-click menu). 

Multiple osteotomies can be done for the same procedure. 

 

 

Warning! During reduction, it is imperative to verify the actual part of the bone 

against the reduction before performing the operation. This is may be due to the 

limitation of presenting the anatomy in 2D. It is imperative to evaluate additional X-

ray views and consider the possible in-vivo differences. 
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Defining Fragments 

 To define fragments: 

1. Select the Define Fragment  tool in the toolbar or select Basic Tools  Fragments  

Define Fragment in the menu bar. Make a series of clicks along the outline of the fragment 

to be moved. 

 

2. Close the outline drawing of the fragment by double-clicking. You now have a closed shape 

that you can drag to a new position: 

 

You can now reposition or adjust the selection of the fragment as required using any of the 

following options: 

• You can rotate a fragment by using its yellow rotation handle. 

 

Selection Box 

Center of Rotation 
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• The red dot in the center of the fragment that you have traced is its center of rotation. 

Click the handle and move it to rotate the fragment. You can also drag this dot to a new 

position and then rotate the fragment. 

• You can flip the fragment using the Flip Implant/Fragment  tool. 

• You can duplicate this fragment by right-clicking on the fragment and selecting the 

Duplicate Fragment  tool. 

• To delete the fragment, use the Delete  tool. This option only removes the fragment 

itself. 

• If you also want to remove the blank space where the fragment was (its original 

location), right-click on it and then click select Delete again. 

• Return the fragment to its original location and orientation by right-clicking the fragment 

and selecting Reset Segment. 

 

• To send the fragment forward or backward on the image, right-click on the fragment and 

select Bring Fragment to Front or Send Fragment to Back. 

Lasso Fragments 
Lassoing fragments means to simply draw a line around the area of the image that contains the 

fragments to be moved. 

 To lasso fragments: 

1. Select Basic Tools  Fragments  Lasso Tool in the menu bar. 

2. Click and hold down the mouse button and drag the mouse around the area to be moved. A 

line is drawn as you move the mouse. You must complete the outline to create the 

fragment. 

  

After the fracture is reduced, you can add implants for fixation as described previously. 
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Special Trauma Template Features 
Some TraumaCad trauma templates have special features, including: 

• Plate Bending, page 63 

• Grouping Templates, page 63 

• Handling Screws in Locking Compression Plates, page 65 

Plate Bending 
Some plates used in trauma procedures can be bent to better conform to the curvature of the 

bone. Such plates display a series of red points on the template on the image. The plate can be 

bent at each of these points, as needed. 

For example, the figures below show examples of such a plate before and after bending: 

  
Before Bending After Bending 

 To bend a plate template: 

• Click a red point on the plate template on the image, and while holding down the mouse 

button, move to bend the plate to the required position. Repeat for other points on the 

plate, as needed. 

Grouping Templates 
Some templates are grouped by default. For such, the group items are surrounded by a yellow 

box, which indicates the boundaries of the group. 

In the example below the grouped template contains both a plate and screws. For a grouped 

template, you can manipulate the properties of each element within the group individually. The 

figures show the same template before and after resizing the plate.  

Red Point 
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Plate Before Resizing Plate After Resizing 

You can select any item within a grouped template. The selected item is highlighted in dark 

green. You can only change the size of an item when it is highlighted.  

 

 To create a template group: 

1. Add two or more templates to an image, as well as image fragmentation. 

2. Click one of the templates to select it, and while holding down the Shift key, click another 

template to select it. You can add an unlimited number of items to a group. 

3. Right-click one of the templates you selected and select Group. The templates are now 

grouped. Grouped items remain grouped until you physically ungroup them. 

 

 

Note: Templates grouped in this fashion are only grouped in this image, and not 

within the TraumaCad template library. 

Grouped Items 

Handle 

Selected Item 
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Handling Screws in Locking Compression Plates 
Locking Compression Plates (LCPs) can use two different types of screws, as follows: 

• Locked screws: Screws used in locked position are set at an angle to the template and this 

angle cannot be changed. Screws of this type have a threaded head. For such screws, it is 

important that the hole in the plate into which they are inserted be exactly the size of the 

screw. 

• Unlocked screws: A screw used in unlocked position can be rotated (axial movement), which 

means that you can change its angle on the image, but its connection point remains 

constant. 

In LCP plates, the smaller holes in the plate are for locked screws and the larger holes are for 

unlocked screws. 

 

Locked and unlocked screws appear differently on the image, as follows: 

  
Locked screw Unlocked screw 

In LCP templates, several options are available for handling the screws within the template. 

You can: 

• Lock a screw 

• Unlock a screw 

• Remove a screw 

• Remove all screws 

Unlocked screw 

Locked screw 
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To use one of these options, simply right-click a screw in the template and select the 

relevant option in the right-click menu. 

If you remove a screw from a template, you can re-attach it by right-clicking the hole where 

the screw should be affixed and selecting Re-attach Screw in the right-click menu. 
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3D SUITE (OPTIONAL) 

The TraumaCad 3D module enables you to view images, such as CTs and MRIs, in three 

dimensions using Multi-Planar Reconstruction (MPR) or Maximum Intensity Projection (MIP). 

The images are shown in Axial, Coronal, Sagittal and Oblique views. In addition, the user can add 

three-dimensional templates to the image in order to do pre-operative planning.  

 

Note: The 3D suite is an optional add-on that can be purchased separately. 

Contact Brainlab Sales for more information. 

Opening a 3D Image 
To enable the 3D procedure, select a study with 6 or more images.  

Select the 3D procedure in the Procedure Selection window. 

Choose Left or Right laterality and then click the Accept to open the series in the main view. 

 

 



Planning Your Surgery 

 68 

Navigating on MPR Images 
The series opened is shown initially with Axial, Coronal and Sagittal views. The yellow lines on 

the images represent the localizer lines, which help show the location of the image in relation to 

the other views. 

To change the location of each slice, scroll in the active window using the mouse wheel or click 

and drag with the mouse button on the yellow localizer lines. 

 

Note: Only series in Axial orientation can be displayed in 3D mode. 

The lower-right view initially shows the Axial image. This view can be changed to either Coronal 

or Sagittal view using the respective button, or to any required Oblique view using the aqua 

localizer lines. 

To change the orientation of this view, click the red holding points and rotate the aqua localizer 

line to the preferred Oblique view. 

 

 

Note: The orientation chosen to be shown in the lower-right view has its aqua 

localizer lines shown in the two orthogonal views. 

Changing the View Type to MIP 
To change the bottom-right image to an MIP view, select the MIP radio button.  

The MIP view can be shown in Axial, Coronal or Sagittal orientations only. 

Adding a 3D Template 
The procedure for adding a 3D template to the image is identical to that for adding a 2D 

template. For more information, see page 53. 

For MPR views, the outline of the template is shown according to the slice location and 

orientation. For MIP views, the template is shown as a complete projection of the implant. 

Templates appear by default in color, but can be changed to grayscale. 

The following button appears, as shown in the previous image: 

• Locate Implant: Scrolls all the views to the template location, meaning that this template is 

shown in all the views. 

The implant is also shown in a separate navigation window, in order to allow easier orientation 

and rotation of the implant. 
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Note: Moving or rotating the implant on one of the views affects its position and 

orientation on all other views. 

Using the Implant Navigation Window 
The Implant Navigation window shows the implant according to the orientation of the currently 

active view. To change the orientation, click and drag with the mouse button in the Implant 

Navigation window. The changes are reflected in the main views. 

When several 3D templates are placed on the images, the last selected template is shown in the 

Implant Navigation window. 

This window is resizable and can be enlarged by dragging the corner using the mouse. 
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MEASURING THE ANATOMY 
TraumaCad offers a variety of measurement tools and wizards to measure the anatomy per the 

selected procedure. Most of TraumaCad’s measurement tools can be accessed from both the 

Measurement Tools menu and from the Measurements tab. The most frequently used tools can 

also be accessed from the toolbar and by right-clicking on the image. 

All tools are described in the sections that follow, and are organized by TraumaCad procedure.  

TraumaCad offers some automatic features for THR and TKR planning, where the application 

attempts to automatically detect the anatomical regions in the image, evaluate measurements, 

position templates, and create fragmentations for image manipulation such as hip reduction and 

knee alignment.  

In case the image is not automatically detected, you can always continue planning manually. 

 

Note: To obtain quantitative measurements, the image must first be calibrated, as 

described in the Automatically Calibrate an Image section on page 44. 

 

Note: The accuracy of the Angle tool is ± 0.75°, the accuracy of the Ruler tool is ± 

0.24mm and Circle measurement tool is ± 0.18mm. 

Accuracy is also affected by the calibration of the image. Depending on the 

calibration method chosen, the accuracy of the measurement tools can vary. 

USING TOOLS 

To use measurement tools select the tool from the left panel. The tool appears on the image. 

Use the red markers to adjust the tool.  

BASIC TOOLS 

TraumaCad includes several basic tools that can be used to supplement procedure-specific tools: 

• Ruler Tool, page 71  

• Circle Tool, page 71 

• Angle Tool, page 71 

• Interline Angle Tool, page 71 

• Line Tool, page 72 

• Free Hand Line Tool, page 72 

• Arrow Line Tool, page 72 

• Text Annotations, page 72 
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Ruler Tool 
The Ruler tool measures selected portions of an image either in pixels (for uncalibrated images) 

or millimeters (for calibrated images). 

 To use the Ruler Tool: 

1. After loading an image, click the Ruler on the toolbar. 

2. Left-click, hold the mouse button on the image where you want to start measuring and drag 

the mouse without releasing the mouse button until the end of the section to be measured. 

3. Release the mouse. The measurement appears in pixels or millimeters. 

4. Click and drag any of the red dots on the ends of the line to adjust its size. 

Circle Tool 
Use the Circle tool to measure the diameter of objects in the image. 

 To use the Circle tool: 

1. Click Circle in the toolbar. 

2. Click the image in the work area. The Circle tool appears on the image. 

3. Left-click and hold the mouse button inside the circle and drag it to the preferred position. 

4. Click and drag any of the red dots to adjust the size of the circle. The diameter measurement 

(if calibrated in millimeters) is displayed. 

Angle Tool 
Use the Angle tool to measure the angle between two rays. 

 To use the Angle tool: 

1. Click Angle in the toolbar. 

2. Click the image in the work area. The Angle tool is displayed. 

3. Drag the anchors of the tool to the section to be measured. The measurement appears in 

degrees next to the angle. 

Interline Angle Tool 
Use the Interline Angle tool to measure the angle between two lines. 

 To use the Interline Angle tool: 

1. Click Interline Angle in the toolbar. 

2. Click on the image in the work area. The Interline Angle tool appears on the image. 

3. Left-click and hold the mouse button and drag each line to the required position. Use the 

red dots as needed to adjust the lines. 

The angle between the two lines is displayed next to the tool. 
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Line Tool 
Use the Line tool to draw a simple line on the image. 

 To use the Line tool: 

1. Click Line in the toolbar. 

2. Hold the mouse button and draw a line on the image, without releasing the button. A line is 

drawn on the image. 

Free Hand Line Tool 
Use the Free Hand Line tool to draw a freehand line on the image. No measurements are 

associated with this line. 

 To use the Free Hand Line tool: 

1. Click Free Hand Line in the toolbar. 

2. Click the image and hold down the mouse button while you draw a free-hand line on the 

image in any shape, without releasing the button. A line is drawn on the image. 

Arrow Line Tool 
Use the Arrow line tool to indicate an area on the image for further attention. 

 To draw an arrow line on the image: 

1. Click Arrow line in the toolbar.  

2. Drag the mouse on the image towards the area you are indicating. 

An arrow is drawn on the image. 

Text Annotations Tool 
Use the Text Annotations tool to add free text to the basic measurements. When text is added 

to the image, a line shows the connection between the text and the part of the image to which 

it applies. You can drag this text away if it is obstructing the view. 

 To add text annotations to an image: 

1. Click Text Annotations in the toolbar.  

2. Click the image or click a measurement in the image. 

The following window is displayed: 

 

3. Enter your text in the text box. 

4. Optionally, change the text color, font or background color. 
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Note: You can change the default font settings by clicking File  Settings  Text 

and specifying the required setting. 

5. Click OK to save your settings. 
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USING WIZARDS 

Wizards guide you through the process of identifying and marking each of the anatomical 

reference points required for the analysis and marking them on the image. 

 To use the wizards: 

1. Select the Tool from the Measurements menu > Measurements tab. 

 

2. Use the wizard to mark anatomical landmarks on the image for the selected analysis. 

The Magnifying Glass tool is opened to help fine tune and to ensure that your markers are 

located in the correct, exact position. 

 

 

Note: To cancel your last action and return to the previous step in a wizard, click 

the Undo button in the toolbar. 

3. Select the Report tab to generate a report. See Generating Reports on page 170. 

For an example wizard, see Limb Alignment Analysis on page 103. 

 

Note: Click Back to Measurements List to exit the wizard and return to the list of 

measurement tools. This button is available in all measurement tool wizards. 
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HIP MEASUREMENTS TOOLS 

The following hip measurements can be made using TraumaCad hip tools: 

• Auto-Hip, page 75 

• Hip Deformity Analysis, page 78 

• Pre-operative Hip Outcome, page 80 

• Post-operative Hip Outcome, page 81 

• Hip Navigation Planning, page 82 

• Leg Length Discrepancy Tool, page 84 

• Acetabular Index, page 85 

• VCA Angle of Lequesne, page 85 

• Cup Version and LLD Analysis, page 86 

• Center of Rotation, page 87 

• Stem Version, page 88 

Auto-Hip 
Digital preplanning for hip replacement surgery is a common orthopedic surgery procedure used 

to estimate implant size, determine the post-operative geometrical relationship between the 

femur and the acetabulum, the resulting leg length and offset change, and predict any 

geometrical mismatch and difficulty pre-operatively. 

The Auto-hip procedure is a software module for the automatic marking of specific points within 

an anterior-posterior pelvis X-ray image. The Auto-hip procedure is used for pre-operative 

procedures only and will not work on post-operative images where there is an implant in place. 

A set of anatomic landmarks on a pelvic AP X-ray are defined in a way that determines the size 

of the femoral stem and its expected stable position in the femoral canal. Points of interest are 

the femur midline and diameter of its channel, greater trochanters tips, lesser trochanters tips 

and bottom tangent line to the visible ischial tuberoses curves. 

 To use the Auto-Hip tool: 

1. In the Image tab, specify the image view, side and calibration. For details see page 44. 

2. In the Templates tab, select the relevant templates, which are displayed in the Implants tab. 

It is recommended to start the planning with the stem component. 

3. Drag and drop or double-click a template in the Implants tab to add it to the image. 

The application automatically detects the anatomical regions in the image. A Leg Length 

Discrepancy tool is added to the image, and the selected stem is positioned in the femoral 

channel according to the selected side (right or left). This feature also automatically defines 

a fragment according to the suggested femur head osteotomy line. 
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Even though the tool automatically selects and places the stem, it is recommended to fine-

tune its position, rotation and adjust the size in the Implant Properties window. Also the LLD 

tool can be fine-tuned by dragging the red anchors and by dragging the fragment. 

4. Select a cup template. The cup is automatically positioned in the area of the acetabulum. 

5. Right-click the cup, stem or the fragment, and select Attach Stem to Cup. This action assists 

in visualizing the hip reduction. The stem and fragment are then automatically attached to 

the cup so that the attachment point of the stem is positioned on top of the attachment 

point of the cup. When the cup and stem are positioned automatically, the fragment moves 

accordingly, as shown below: 
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Note: To detach the stem from the cup, select the Detach Stem from Cup in the 

Right-click menu. 

A default attachment point is automatically selected. If required, you can select a different 

attachment point in the Implant Properties window on the image. 

The Offset changes and Leg length changes appear automatically on the image. The 

pre-reduction and post-reduction measurements appear at the top of the Templates tab. 

The difference between leg lengths can be measured automatically using the LLD tool or 

manually by checking the Use Clinically Measured LLD checkbox and entering the value. 

  

 

 

Note: If you wish to plan Hip Replacement manually, in Settings  Planning 

unselect Use automatic hip planning. TraumaCad remembers your preferences and 

saves the planning mode you have selected for the next time you choose the Hip 

procedure. 
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Hip Deformity Analysis 

 To use the Hip Deformity Analysis wizard: 

1. Use the wizard to mark the 10 relevant points on the image. 

2. Enter the last (tenth) measurement. The window now appears as shown below:  

 

Once you have entered the 10 measurements the calculated measurements are displayed in 

a table at the top of the Measurements tab. 

3. Click the associated checkbox to display the following calculated measurements: 

• Sharp Angle: Measured from a pelvic horizontal at the teardrop’s height to the 

superolateral acetabular margin (the lateral rim). This measures the inclination of the 

acetabulum after fusion of the triradiate cartilage. 

• Central Edge Angle: Measured from a line that passes through the femoral head center, 

which is perpendicular to the pelvic horizontal line, to a line that passes from the center 

of the femoral head to the lateral rim. This measures the acetabular dysplasia. Select the 

Show central edge angle checkbox to display this measurement. 
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• Reimer's Index (the hip migration percentage): Vertical lines are drawn through the 

edges of the femoral head and the lateral rim of the acetabulum. The index is calculated 

by dividing the uncovered part of the head by the entire width of the head. This 

measures the acetabular coverage of the femoral head. Select the Show Reimer’s index 

checkbox to display this measurement. 
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Pre-operative Hip Outcome 
The pre-operative and post-operative Hip Outcome define geometric anatomical measurements 

to determine the center of rotation and anatomical relationship before and after implant 

positioning.  

The tools provide the option for post-op evaluation and compare the pre-operative status, 

desired planning and operative results. 

The following measurements are taken: 

• Center of Rotation 

• Femoral Offset 

• Medial Offset 

• Ilioschial Offset 

• Hip Height 

 To use the pre-operative Hip Outcome: 

1. Select Pre Op in the Hip Outcome sub-menu. 

2. Follow the 13 steps in the wizard to mark points on the image. You can drag points to move 

them to a new position. 

 

When the measurements are displayed it is recommended to zoom in and fine-tune lines 

according to the patient’s anatomy. 



Measuring the Anatomy 

 81 

Post-operative Hip Outcome 

 To use the post-operative Hip Outcome: 

1. Select the Post Op in the Hip Outcome sub-menu. 

2. Follow the 17 steps in the wizard to mark points on the image. You can drag points to move 

them to a new position. 
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Hip Navigation Planning 
The Hip Navigation Planning tool is designed for navigated Total Hip Replacement cases,  

offering surgeons to adjust the cup orientation to the functional reference plane using a 2D AP 

x-ray image. 

The navigation tool  in combination with the Hip Navigation software, calculates the individual 

patient pelvic tilt. For this purpose, the TraumaCad plan has to be exported and loaded into the 

Hip Navigation system.  

The following measurements are taken: 
 

• Most lateral point of the left & right iliac crest 

• Left & right anterior superior iliac spine (ASIS) 

• Left & right posterior inferior iliac spine (PIIS) 

• Left & right most lateral point of the pelvic inlet 

• Most cranial point of the pubic symphysis 

• Three points on the femoral head circumference 

  

 How to use the Hip Navigation Planning tool:  

1. Select the Hip Navigation Planning in the Measurements tab.  
2. Follow the 12 steps in the wizard to mark points on the image. You can drag points to move 

them to a new position. Make sure that all landmarks are clearly visible.  
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Note: For a correct calculation of the pelvic tilt, the image has to be a true AP 
pelvic image. The pelvis must not be rotated around its longitudinal (i.e. cranial-

caudal) axis in the X-ray. 
If the measurement tool detects a large pelvic rotation in the X-ray, the user is 
informed that the TraumaCad plan cannot be used for pelvic tilt adjustment in the 
Hip navigation software. 
 

  

 

Note: The Navigation Planning tool can only be used on x-ray images with the 
KingMark calibration device in a supine patient position. A notification will appear if 
no KingMark calibration device is detected. 
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Leg Length Discrepancy Tool 
The Leg Length Discrepancy measurement tool enables you to measure leg length discrepancy. 

A tangent line is drawn by choosing two points at the most inferior points on the ischial 

tuberosities. From this reference line, two vertical lines should be drawn toward identical 

anatomical landmarks on each proximal femur (the center of the lesser trochanter, top of the 

greater trochanter and so on). 

The text below the horizontal line indicates the discrepancy between the right and left side and 

the distance between the two points. If there is no discrepancy, the number 0 is shown. 
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Acetabular Index 
A wizard opens to guide you through the usage of the tool, as described on page 103. 

VCA Angle of Lequesne 
The anterior center-edge (VCA) angle quantifies the anterior coverage of the femoral head. 

Angles less than 20° are considered abnormal. 

The VCA angle is calculated from a false-profile radiological view of the pelvis. The patient 

stands at an angle of 65° oblique to the X-ray beam, with the foot on the affected side parallel to 

the X-ray cassette. A vertical line through the center of the femoral head subtends the VCA 

angle by connecting with a second line through the center of the hip and the foremost aspect of 

the acetabulum. 
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Cup Version and LLD Analysis 
When the acetabular component of a total hip replacement is viewed at an angle, it projects as 

an ellipse. This projection can be mathematically proven to follow the general formula of an 

ellipse, and translated to ante/retroversion. 

A horizontal reference line is drawn on the pelvis (between the ischial tuberosities, teardrops 

and so on) and three red markers are placed on the edge of the cup. The projection of the 

ellipse is then translated into ante/retroversion of the cup. 

 

Warning! The image has to be a true AP pelvic image. Otherwise, the 

measured ante/retroversion will be miscalculated. 

A Leg Length Discrepancy (LLD) tool is also added to the image. For more information see Leg 

Length Discrepancy Tool on page 84. 
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Center of Rotation 
The Center of Rotation measurement tool helps you to find the approximate center of rotation 

of the injured acetabulum by locating the center of rotation of the contralateral hip. A horizontal 

line is placed on the pelvis between two teardrops. You then adjust a circle on the acetabulum 

of the healthy hip and the tool places a matching circle on the injured hip. 

 

After the Center of Rotation Tool has been placed on the image and adjusted to the correct 

location, you can browse to the Templates tab and select the Cup templates. If you double-click 

a Cup template, it is automatically placed in the correct location with the correct size on the 

image. 
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Stem Version 
When the femoral component of a total hip replacement is ante/retroverted, the projected 

neck-shaft angle changes accordingly. The new projected neck-shaft angle can be 

mathematically translated to ante/retroversion of the stem. 

First, define the neck shaft angle of the selected stem from the dropdown list. Then, a center-

line finder is placed on the femoral stem, two red markers are placed on the femoral neck and 

three red markers are placed on the edges of the implanted head. The projection of the neck-

shaft angle is then translated into the ante/retroversion of the stem. 

 

Warning! The image must be a true AP pelvic one with neutral rotation of the 

hip joint. Otherwise, the measured ante/retroversion will be miscalculated. 

The Stem Angle defines how much the stem is rotated compared to the AP plane of the image. 

In order to calculate the rotation of the stem, you need to know the angle between the axis of 

the stem and the axis of its connection to the cup. The default angle is 135°. To change the 

angle, click to open the angles values. 
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KNEE MEASUREMENTS 

The following knee measurements can be made using TraumaCad measurements tools: 

• Auto-Knee, page 90 

• Knee Resection Tools, page 91 

• AP Resection Lines, page 91 

• Long Leg Resection Line, page 93 

• Limb Alignment Analysis, page 94 

• Center Line Finder, page 96 

• Simple Line, page 97 

• High Tibial Osteotomy, page 98 

• Joint Line, page 99 
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Auto-Knee 
Auto-Knee functionality provides a quick method to perform Total Knee Replacement planning 

for AP and LAT images.  

With this functionality, the application attempts to automatically detect the anatomical regions 

in the image, a resection line is added to the AP image, and implant sizing and position is 

determined both for AP and LAT images. This feature also automatically creates fragments to 

allow visualizing the expected knee alignment. 

The AP Knee resection line is automatically positioned according to patient anatomy when the 

tool is selected or a template is selected. 

The template sizing for the femoral component size is evaluated according to the lateral image, 

while the tibial component size is according to the AP image. In case one of images is missing, 

then automatic sizing is not applied for the relevant template. 

The Auto-Alignment tool visualizes alignment correction. Once the femoral and tibial 

components and the resection lines are placed in the image, auto-alignment functionality is 

available. This tool creates a tibial fragment and re-positions it together with the tibial 

component and resection line until they are located in parallel to the femoral component. To 

perform auto-alignment, right click on one of the templates and select Show Alignment.  
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Knee Resection Tools 
The Knee resection tools assist the surgeon in planning the desired femoral distal cut and 

proximal tibial cut perpendicular to the mechanical axes. The tool measures the size of the 

medial and lateral bone cuts. 

The tools mark the true mechanical axis of the bone on full length images or enable a choice of 

femoral cut angle, deviating from the anatomical axis, on a limited knee AP view. 

The resection line is located by default at 90° to the mechanical axis. It can be rotated by moving 

the resection anchor. A dotted line remains to indicate the original location of the resection line, 

and an angle added to represent the varus/valgus rotation. 

The program attempts to apply the resection line automatically as described above. If the 

automatic placement is not successfully, it is possible to apply the resection line manually.  

When applying the resection line manually, in Settings  Planning you can set the default 

femoral and tibial cut level, the default femoral and tibial cut level side and the default femoral 

anatomic angle.  

From the left panel you can select to show/hide the Resection Line tools. 

AP Resection Lines 
The AP Resection Lines tool is used for AP images where only the knee joint is shown.  

The femoral mechanical axis is assumed to be 6° to the anatomical axis and appears as a dotted 

line. The angle can be changed by dragging the dotted line.  

 To use the AP Resection Line tool manually: 

• If the AP Resection Line tool could not be placed automatically, follow the 12 steps in the 

wizard to mark anatomical landmarks on the image. You can later, at any stage, 

reposition any dot by dragging it to a new position. 

The results appear in the left panel: 

 Femoral values – Medial and Lateral 

 Tibial values – Medial and Lateral  

 Femoral Anatomical Angle – Anatomical to mechanical angle 

 Anatomical Tibiofemoral Angle – Pre and Post 

 Femoral Mechanical Cut Angle 

 Femoral Anatomical Cut Angle 

 Tibial Cut Angle 
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Note: If you wish to plan Total Knee Replacement manually, in Settings  Planning 

unselect Use automatic knee planning. TraumaCad remembers your preferences 

and saves the planning mode you have selected for the next time you choose the 

Knee procedure. 
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Long Leg Resection Line 
The Long Leg Resection tool is used for AP images where the full leg length is displayed. 

 To use the Long Leg Resection tool: 

1. Follow the 13 steps in the wizard to mark measurement points on the image. When 
completed you can fine-tune the measurements by dragging points to a new position. 

 

The results appear in the Measurements tab. 

• Femoral values – Medial and Lateral 

• Tibial values – Medial and Lateral  

• Femoral Anatomical Angle – Anatomical to mechanical angle  

• Anatomical Tiobiofemoral Angle – Pre and Post 

• Mechanical Tiobiofemoral Angle – Pre and Post 

• Femoral Mechanical Cut Angle 

• Femoral Anatomical Cut Angle 

• Tibial Cut Angle  

2. From the left panel you can select whether to show/hide Resection Lines, Alignment Lines 

or Mechanical Axes on the image. By default all lines are shown. 
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Limb Alignment Analysis 
Knee limb alignment analysis enables orthopedic surgeons to take unilateral or bilateral 

anatomical measurements, compare them to normative standards and to simulate corrective 

procedures. Easy-to-use wizards help surgeons produce a wide range of anatomical 

measurements. 

The steps for using this tool are the same as those described in the Marking Anatomical Points 

section on page 112. Consult this section and its subsections for more details. 

Knee Outcome 
Knee Outcome is used to evaluate the position of the femoral and tibial TKR Implants on a post-

operative image for both AP and LAT views.  

 To use the Post-operative Knee Outcome 

AP View: LAT View: 

  

1. Follow the 12 steps in the wizard to mark points on the image. When completed and 
measurements are displayed on the image, you can drag points to move them to a new 
position. 

2. If you wish to evaluate the LAT view as well, select the LAT image and then in the 

Measurements tab, click Back to Measurements List and select Knee Outcome. 
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The results appear in the Measurements tab: 

AP View: 

• Femoral: AP Femoral Anatomical Alignment  

• Tibial: AP Tibial Alignment  

• If α > 90 = Valgus 

• If α < 90 = Varus 

LAT View: 

• Femoral: Femoral Flexion  

• Tibial: Posterior Slope – if α < 90 = Anterior, If α > 90 = Posterior 

 



Measuring the Anatomy 

 96 

Center Line Finder 
The Center Line Finder measurement tool is used to locate the center line of long bones. After 

adjusting the four points to the edges of the bone, the center line is displayed. 
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Simple Line 
Using this tool, a line is displayed on the image that can be manipulated. If the line crosses a 

second line, such as a Center line or Joint line, the angle between the lines is calculated. 
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High Tibial Osteotomy 
This measurement tool is used to measure the correction angle of a High Tibial Osteotomy 

(HTO), which is the angle between a line that is drawn from the center of the femur to the 62% 

coordinate of the knee, and a line from the 62% coordinate to the center of the tibiotalar joint. 

 To use the High Tibial Osteotomy tool: 

Place the circle around the femoral head, the middle line on the tibial plateau and the distal 

line on the tibial plafond.  

 



Measuring the Anatomy 

 99 

Joint Line 
The Joint Line measurement tool enables you to select in advance, the inclination, location and 

orientation of the Joint line for various measurements, such as deformity evaluation, joint 

replacement, preoperative planning and so on. 

 

• You can adjust the desired angle and its orientation, as shown below: 

   

• You can also determine the joint line intersection by adjusting the ratio. 
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PEDIATRIC MEASUREMENTS 

The following pediatric measurements can be made using TraumaCad measurements tools: 

• Hip Deformity Analysis, page 101 

• Limb Alignment Analysis, page 103 

• Acetabular Index, page 103 

• Reimer’s Index, page 104 

• VCA Angle of Lequesne, page 104 

• Neck Shaft Angle, page 105 

• Head Shaft (Slip) Angle, page 106 

• Articulo-trochanteric Distance, page 107 

• Epiphyseal Index, page 108 

• Tibiofemoral Angle, page 109 

• Metaphyseal-Diaphyseal Angle, page 110 
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Hip Deformity Analysis 
When using this measurement tool, first select the module that fits the patient’s bone age by 

the ossification stage of the femoral head. The options are: 

• Fused Triradiate Cartilage 

• Full/Partly Ossified Femoral Head 

• Non-Ossified Femoral Head 

Follow the steps in the wizard and mark the relevant points on the image corresponding to each 

step. 

 

The calculated measurements are displayed in the left panel. The following three calculated 

measurements can also be displayed on the image, as follows: 

• Hilgenreiner Angle: The angle of inclination of the ossified acetabular roof is measured 

on an AP radiograph of the pelvis. This is regarded as an estimate of acetabular 

development. This involves drawing a Hilgenreiner line joining the superior margins of 

the radiolucent triradiate cartilages. Another line is then drawn from the superolateral 

margin of the ossified acetabulum to the superolateral margin of the triradiate cartilage. 

In the neonate, the angle of intersection is normally less than 30°, and by two years of 

age, the angle is normally less than 20°. Select the Show Hilgenreiner Angle checkbox to 

display this measurement. 

• Central Edge Angle: This angle is measured from a line that passes through the femoral 

head center and is perpendicular to the pelvic horizontal line, to a line that passes from 
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the center of the femoral head to the lateral rim. It measures the acetabular dysplasia. 

Select the Show Central Edge Angle checkbox to display this measurement. 

• Reimer's Index (the hip migration percentage): Vertical lines are drawn through the 

edges of the femoral head and the lateral rim of the acetabulum. The index is calculated 

by dividing the uncovered part of the head by the entire width of the head, which 

measures the acetabular coverage of the femoral head. Select the Show Reimer’s Index 

checkbox to display this measurement. 
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Limb Alignment Analysis 
A wizard opens to guide you through the usage of the tool, as described on page 112. 

Acetabular Index 
A wizard opens to guide you through the usage of the tool, as described on page 85. 

The angle of inclination of the ossified acetabular roof is measured on an AP radiograph of the 

pelvis. This is regarded as an estimate of acetabular development. 

The most commonly used method for measuring the angle is Caffey’s. This involves drawing a 

horizontal line joining the superior margins of the radiolucent triradiate cartilages. Another line 

is then drawn from the superolateral margin of the ossified acetabulum to the superolateral 

margin of the triradiate cartilage. 

In the neonate, the angle of intersection is normally less than 30°, and by two years of age, the 

angle is normally less than 20°. 

 

 

  



Measuring the Anatomy 

 104 

Reimer’s Index 
The Reimer’s Index measures the hip migration percentage. A circle is adjusted to the ossified 

femoral head. The vertical line is then placed continuous with the lateral rim of the acetabulum. 

The index is calculated by dividing the lateral part of the circle by the diameter of the circle. This 

measures the acetabular coverage of the femoral head. 

 

 

VCA Angle of Lequesne 
The tool appears on the image as described on page 85. 
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Neck Shaft Angle 
Hip deformity can be evaluated by measuring the angle between the center of the shaft and the 

center of the neck of the femur. 

The normal femoral neck-shaft angle in children changes with age, being approximately 150° at 

birth and gradually reducing to approach the adult value of 130°. It is important that the 

radiograph is taken with the patient correctly positioned with the leg held in a neutral position 

and the patellae facing forward, as external rotation of the leg increases and internal rotation 

decreases the projected neck-shaft angle. 

The tool appears on the image. 
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Head Shaft (Slip) Angle 
The head shaft (slip) angle of Southwick has been used to characterize slip severity in slipped 

capital femoral epiphysis. The angle is measured on the frog-lateral radiograph of the pelvis. A 

line is drawn between the anterior and posterior tips of the epiphysis at the physeal plate level. 

Then, a perpendicular line is drawn to this Epiphyseal line. Next, a line is drawn along the mid-

axis of the femoral shaft. The Epiphyseal-shaft angle is the angle formed by the intersection of 

the perpendicular line and the femoral shaft line. It is measured for both hips, and the 

magnitude of slip displacement is the angle of the involved hip minus the angle of the 

contralateral normal hip. Using the measurement of this angle, a slipped capital femoral 

epiphysis can be classified as mild (less than 30°), moderate (from 30° to 50°) or severe (greater 

than 50°). If involvement is bilateral, 12° can be used as the control angle. 
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Articulo-trochanteric Distance 
This measurement tool measures the vertical distance from the superior articular surface of the 

femoral head to the proximal point of the greater trochanter along the anatomical axis of the 

femur. This enables you to assess the degree of growth arrest of the neck-head growth plate. 
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Epiphyseal Index 
The Epiphyseal Index is the quotient between the largest width and the largest height of the 

epiphyseal nucleus, measured on the X-ray plate and shown in percentage of sphericity. This 

provides an indication of the degree of flattening of the epiphyseal nucleus induced by necrosis 

or mechanical deformity. 
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Tibiofemoral Angle 
The Tibiofemoral Angle is the angle created by the intersection of the anatomical axes of the 

femur and the tibia. 
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Metaphyseal-Diaphyseal Angle 
The Metaphyseal-diaphyseal Angle is the angle created by the intersection of a line through the 

transverse plane of the proximal tibial metaphysis, with a line perpendicular to the long axis of 

the tibial diaphysis. This angle represents the degree of deformity of the proximal end of the 

tibia in a patient with clinical bowleg deformity, and permits early differentiation between 

infantile tibia vara and physiological bowleg before the appearance of the radiographic changes 

of tibia vara. 
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DEFORMITY MEASUREMENTS 

Currently, the following automatic deformity measurement tools are available: 

• Limb Alignment Analysis, below 

• Taylor Spatial Frame – Pre Op, page 121 

• Taylor Spatial Frame – Post Op, page 123 

Limb Alignment Analysis 
The Limb Alignment Analysis tool enables orthopedic surgeons to measure and display the 

anatomic and mechanic axes of deformed limbs. The common joint angles are automatically 

calculated and compared to normative standards and are used to simulate corrective 

procedures. The anatomical measurements can be unilateral or bilateral.  

Preplanning for lower limb deformity correction surgery is the art of describing the properties of 

the deformation and the means of its correction. 

The user must draw a model assessing the transfer of load from the point of which it is applied 

to the limb – usually at the center of the femoral head, through its geometrical relations with 

the major joints and to the center of the ankle, where it is transferred to the ground. 

The purpose of defining the axes of load is to be able to define the centers of any anatomic 

deformation along the pass of bony structures, calculate its magnitude and suggest the best 

means of correction. 

The outcome of the procedure is a plan describing where a bone should be cut and the angle it 

needs to rotate around a chosen center of rotation, in order to re-establish the correct length 

and axis for load transfer. 

 To perform limb alignment analysis: 
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1. Use the wizard to mark anatomical landmarks on the image for limb alignment analysis, as 
described below. 

2. Use the CORA tools, as described on page 116. 

3. You can simulate osteotomies and implant fixation, as described on page 118. 

Marking Anatomical Points 
Select the Limb Alignment Analysis measurement tool in the Measurements tab. 

• For an AP image, specify whether you want to produce unilateral versus bilateral 

measurements. 

 

• The wizard guides you through the process of identifying and marking each of the 

anatomical reference points required for performing the automatic leg alignment analysis 

and marking them on the image. 

• A magnifying glass opens automatically that enlarges the relevant area to help you position 

the points. 
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The following shows an example of the image after the 7th point has been marked:  

 

• After you mark the eighth point, the window appears as follows: 
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• You can now fine tune the position of the measurement points by zooming in the image and 

dragging them. 

• If for any reason you want to skip that stage and perform osteotomy simulation in a 

predetermined location, click the Skip Wizard button in the Measurements tab and mark 

only two reference points for the femoral head and the ankle joint, as shown in the 

following image: 

 

 

Note: If the image only shows part of the leg, for example when the femoral head is 

not in the image and you are using the Skip Wizard option, then you must estimate 

the line to the femoral head’s position at the top of the image using the CORA tools, 

as described on page 116. 

At any stage after marking the anatomy using the wizard, you can click the Show Limb 

Alignment Analysis checkbox under the table to hide/unhide the anatomical measurements 

on the image. 
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Limb Alignment Analysis Results 
The following unilateral measurements are calculated in an AP image: 

• mLPFA: Mechanical Lateral Proximal Femoral Angle 

• mLDFA: Mechanical Lateral Distal Femoral Angle 

• mMPTA: Mechanical Medial Proximal Tibial Angle 

• mLDTA: Mechanical Lateral Distal Tibial Angle 

• JLCA: Joint Line Convergence Angle 

• MAD: Mechanical Axis Deviation 

• Femur: Total length of femur segment 

• Tibia: Total length of tibia segment 

• Total Length: Total limb length 

The results appear in the Measurements tab:  

 

In the table, normal values appear green and abnormal values appear red. 
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CORA Tools 
The Center of Rotation of Angulation (CORA) is the intersection of the proximal segment’s axis 

and the distal segment’s axis. The angle created is the magnitude of the deformity in the frontal 

plane. 

You can now use the CORA tools to establish where to perform the osteotomy. 

The CORA can be found by establishing either the anatomical or the mechanical axis of each 

bone. Different tools are provided for each of these options. 

Typically, one tool is placed on the proximal segment and one on the distal. The CORA is found 

at the intersection between the two tools. For multiple deformities, recalculate above and 

below each deformity, either on the same bone or on multiple bones. 

For each CORA, you must use either two mechanical tools or two anatomical tools. 

The illustrations in the Measurements tab guide you through the process. 

 

Note: We recommend that at this stage you uncheck the Show Limb Alignment 

Analysis checkbox so that the limb alignment lines are not shown, thus enabling you 

to concentrate on finding the CORA. 

 To use the CORA tools: 

1. In the Measurements tab, hover with the mouse over an anatomical part of a leg to display 
the relevant CORA tools for that leg part, as shown below:  

  

 

2. Click to select the first tool. The tool appears on the image. 

3. Hover over the illustration again to select the second tool. Both tools now appear on the 

image, as shown below: 
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4. Zoom in the image to better see where the lines intersect. 

The CORA (dashed line) and the osteotomy lines (orange line) are indicated at the 

intersection between the tools and it shows its bisectoral angle, which is 16° in this example. 

Both lines appear on top of each other by default. 

You can move the osteotomy line to where you plan to perform the osteotomy. By default, 

it is positioned on the CORA. 

 

The following options are provided when you right-click the CORA: 

CORA Line 

Osteotomy Line 
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• Delete CORA: Deletes the selected CORA from the image. 

• Disable Osteotomy: Hides the osteotomy line in the image, but leaves the CORA. 

• Hide/Show CORA Lines: Hides/shows the CORA lines in the image. 

• Rotation Axis (ACA): After the level of osteotomy is defined, the type of wedge can be 

selected (open, closed, neutral [through the CORA]), or Manually Positioned Center of 

Rotation can be selected for the moving the fragment. 

• Reuse Line: Automatically creates another CORA line (for example CORA 2) with the 

same definitions, which you can then modify. 

• Color: Enables you to specify the color of the tools in the image. 

5. In the Measurements tab Wedge section, select either the Open, Neutral or Close 

osteotomy wedge. You can also right-click the osteotomy line and select the Rotation Axis 

(ACA)  User Defined option, and then the wedge point can be manually moved to any 

location. 

6. To perform multiple osteotomies, you can add another CORA by clicking the Add CORA 

button. After you add another CORA, it appears as a tab in the Measurements tab. 

Up to four CORAs can be added. 

7. Click the Finish and Cut button. Fragments of the image are then automatically created 

around the osteotomy line, one on the top and one on the bottom, as shown in the 

following image: 
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8. If you want to automatically align the leg, select either the Full Alignment option or the 

Rotation Only option in the Measurements tab. Full alignment performs both translation 

and rotation. 

9. To automatically align the leg, click the Auto Alignment button in the Measurements tab. 

The image fragments of the leg are then automatically aligned, as shown below: 
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The new mechanical angles of the axes are shown in the Post column of the Measurements 

tab. 

10. Check the values that appear in the Measurements tab. Normal values appear green and 

abnormal values appear red. 

The angle and opening of the wedge are indicated as follows: 

  

 

Note: The Undo Cut button returns the image to the state it was before the Finish 

and Cut button was clicked. The Undo Alignment button returns the image to the 

state it was before the Auto Alignment button was clicked. 

11. At any stage, you can manually align the femur and tibia fragments by clicking the fragments 

and moving them as required. 
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Taylor Spatial Frame  
Taylor Spatial Frame (TSF) is an external fixator used to treat complex fractures and bone 

deformities. It is a hexapod device based on a Stewart platform, which consists of two aluminum 

rings connected by six struts. Each strut can be independently lengthened or shortened. 

Connected to a bone by wires or half pins, the attached bone can be manipulated in six axes. 

Angular, translational, rotational and length deformities can all be corrected simultaneously 

with the TSF. 

The TSF wizards offer pre-operative planning on long-leg images and post-operative evaluation 

on the x-ray images with the TSF device. The post-op case values can be used on the 

SpatialFrame.com website to generate according prescriptions.  

Taylor Spatial Frame – Pre Op 
The pre-op planning allows you to analyze the limb alignment, define osteotomies based on the 

CORA method and planning ring positions on long leg films. 

 To use the Taylor Spatial Frame Pre Op tool: 

1. The wizard guides you through limb alignment analysis as described in the Limb Alignment 

Analysis section, followed by CORA planning using the same tools as described above. 

Follow all the wizard steps, including Finish and Cut (mandatory) and Auto Alignment 

(optional). Once the osteotomy planning is ready, the TSF rings can be added to the plan. 

2. To insert rings, go to the Templates tab and choose the desired ring templates. Position the 

rings in the correct location and press the Lock Rings to Segments button to associate them 

with the segments. The rings can still be moved even when locked. At any point you can 

release the ring/segment association by pressing the Lock Rings to Segments button again.  
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3. Once planning is completed and rings are correctly positioned, select the Undo Alignment 

option in order to bring the segments and rings back to the pre-op state. 
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Taylor Spatial Frame – Post Op 
In the TSF Post Op evaluation tool, you position the rings and the master tab in their proper 

positions on two images: an AP image and a LAT image. Both images are required to use this 

tool. All required parameters for the use of the TSF device are calculated.  

 

Warning! Use of the TSF tool in TraumaCad presumes that the patient already has 

the required fixation device attached to his/her body and that the osteotomy has 

already been performed.  

Before using the TSF tool, be sure that the images were taken 90° perpendicular 

between them, or as close to 90° as possible. 

Before using the TSF tool, be sure that at least one of the two rings (which is the 

reference frame) in the image is as close as possible to being perpendicular to both 

images (AP and Lateral). 

 To use the Taylor Spatial Frame Post Op tool: 

The following window appears: 

1. Ensure that the selected image is oriented so that the posterior is on the left and the 

anterior is on the right. If it is not, click Flip Left/Right to flip the image accordingly and then 

OK. 

 

After the image has the proper orientation, the window displays as shown below: 
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2. The window shows a ring representing the top frame in both images. Drag the entire ring so 

that it sits exactly on the proximal frame or the distal frame. Alternatively, you can drag the 

red dots to resize the ring. You should select the frame (proximal or distal) that is most 

perpendicular to both images. This frame serves as the reference frame, which must be 

perpendicular to the image plane. 

Note that when you resize the frame on one image, it is automatically resized accordingly on 

the other image. The reference frame can only be moved in one image at a time. 

 

If required, select the ring and open the right click menu to define the Reference Ring 

Position: Auto, Proximal or Distal. 
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3. Position the master tab, which is the small orange square ( ) on the right of the ring, on 

the reference frame so that it is located correctly in both images. Moving the master tab on 

one image automatically moves it correspondingly on the other image. 

 

4. Position the osteotomy line (the orange line ) on the osteotomy in both images. Note 

that when you move it on one image, it automatically moves on the other image. 

5. The Structure at Risk (SAR) point appears on the osteotomy line . You can define the SAR 

using one of the following options: 

• Automatically: Select the Automatic radio button in the Structure at Risk area to 

automatically place the SAR on the osteotomy side to be moved the most. Selecting this 

option always places the SAR triangle at the end of the orange line, as shown above. 

• Manually: Select the Manual radio button to position the SAR at a point of your choice 

on the image. When you select this option, the SAR triangle can be moved separately 

from the orange line. 

6. Next, you define the target positions. In order to define the target position, you can 

optionally use the CORA tools and the Desired Length Changes options to obtain automatic 

positioning assistance (by clicking Auto Alignment after performing the cut), or you can skip 

these steps and define the target position manually after performing the cut. 

For automatic positioning, use the default CORA tools and position them appropriately. For 

more details about using CORA tools, see page 116. 

When selecting this option, you must also specify the required length change in the Desired 

Length Changes field. 
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7. Then, perform the cut by clicking Perform Cut. This makes a fragment out of the segment 

under the osteotomy, which you then position in the correct location on the image. 

 

8. The fragment can be moved automatically or manually. To automatically position the 

fragment, click Auto Alignment. This option positions the fragment on the image, based on 

the CORA lines placement and the Desired Length Changes (as defined before performing 

the cut). Alternatively, you can manually position the fragment by dragging, moving or 

rotating it so that it is in the correct location. 
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The TSF Planning Parameters area shows all calculated parameters for the Taylor Spatial 

Frame tool.  

9. Click Save TSF File to save calculated parameters to a file. 
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TRAUMA MEASUREMENTS 

The following trauma measurements can be made using TraumaCad measurements tools: 

• Limb Alignment Analysis, page 129 

• Diaphyseal Fracture Angulation, page 129 

• Metaphyseal Fracture Angulation, page 130 

• Center Line Finder, page 130 

• Simple Line, page 130 

• Joint Line, page 130 

• Roof Arc, page 131 
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Limb Alignment Analysis 
A wizard opens to guide you through the usage of the tool, as described on page 112. 

Diaphyseal Fracture Angulation 
This measurement tool measures the angle between the long axes of two long bones. The points 

are adjusted to the edges of the bones and the angle between their center lines is measured 

and displayed. 
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Metaphyseal Fracture Angulation 
This tool measures the angle between the long axis of a long bone and the joint line of the bone. 

The points are adjusted to the edges of the bone and its articular surface and the angle between 

them is measured and displayed. 

 

Center Line Finder 
The tool appears on the image. This tool works as described in Center Line Finder on page 96. 

Simple Line 
The tool appears on the image. This tool works as described in the Simple Line section on 

page 97. 

Joint Line 
The tool appears on the image. This tool works as described in the Joint Line section on page 99. 
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Roof Arc 
The roof arc concept was originally described by Matta. It helps determine the amount of intact 

acetabular dome and is a useful method for determining the need for surgery. Measurements 

are made on AP, obturator and iliac oblique views, as follows: 

• A vertical line is drawn to the geometric center of the acetabulum. 

• Another line is drawn through a point where a fracture line intersects the acetabulum 

and again to the geometric center of the acetabulum. 

• Angles drawn in this way represent medial, anterior or posterior roof arcs as seen on AP, 

obturator oblique or iliac views, respectively. 
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SPINE MEASUREMENTS 

The following spine measurements can be made using TraumaCad measurements tools: 

• Cobb Angle, page 133 

• Double Cobb Angle, page 134 

• Triple Cobb Angle, page 134 

• Vertebrae Labeling, page 135 

• Clavicle Angle, page 137 

• Coronal Balance, page 138 

• Sagittal Balance, page 139 

• Lumbar Lordosis Angle, page 140 

• Pelvic Radius Angle, page 141 

• Sacral Obliquity, page 142 

• Spine Slip Angle, page 143 

• Spondylolysthesis, page 144 

• T1 Tilt Angle, page 146 

• Thoracic Kyphosis Angle, page 147 

• Thoracic Trunk Shift, page 148 
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Cobb Angle 
The Cobb Angle measurement is used for evaluation of curves in scoliosis on an AP radiographic 

projection of the spine. 

When assessing a curve, the apical vertebra is first identified. This is the most likely displaced 

and rotated vertebra with the least-tilted endplate. The end/transitional vertebra are then 

identified through the curve above and below. The end vertebrae are the most superior and 

inferior vertebrae that are least displaced and rotated and have the maximally tilted endplate. 

A line is drawn along the superior endplate of the superior end vertebra and a second line is 

drawn along the inferior endplate of the inferior end vertebra. The angle between these two 

lines is measured as the Cobb angle. 

In S-shaped scoliosis, where there are two contiguous curves, the lower-end vertebra of the 

upper curve represents the upper-end vertebra of the lower curve. In some cases, there may be 

a third contiguous curve. 

As a general rule, a Cobb angle of 10° is regarded as a minimum angulation to define scoliosis. 

 To use the Cobb angle wizard: 

• Follow the 4 steps in the wizard to mark measurement points on the image. When 

completed you can fine-tune the measurements by dragging points to a new position. 
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Double Cobb Angle 
The Double Cobb Angle measurement tool works the same as the Cobb Angle tool. See 

page 133 for more details. 

Triple Cobb Angle 
The Triple Cobb Angle measurement tool works the same as the Cobb Angle tool. See page 133 

for more details. 
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Vertebrae Labeling 
This tool enables you to label spine vertebrae. There are various kinds of vertebrae, including: 

• Cervical, designated by C on the image 

• Thoracic, designated by T on the image 

• Lumbar, designated by L on the image 

 To use the Vertebrae Labeling tool: 

1. Click the Cranial button to start labeling from cranial (superior) to caudal vertebrae 
(downwards), or click the Caudal button to label from a lower vertebra upwards. 

2. Select the first vertebra to label in the First Vertebra dropdown list, as shown below: 

  

3. Click the Yes or No button, as appropriate, to indicate whether there are abnormal 

vertebrae. If you select Yes, select the appropriate radio button(s) for the abnormal 

vertebra(ae). 

  

4. Click Accept to label the first vertebra. 

5. Click the first vertebra you want to label, as described in step 3 above. The label is added to 

the image. 
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6. Repeat step 5 as many times as needed to label adjacent vertebrae in the direction defined 

in step 1. TraumaCad automatically labels the next vertebra. It also takes any abnormal 

vertebrae into account for this purpose. 

 

7. After you have labeled the vertebrae in the image, click Finish. You can move the labels on 

the image using standard TraumaCad methods. 
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Clavicle Angle 
The Clavicle Angle tool evaluates shoulder balance by measuring the horizontal tilt of T1 and the 

clavicle angle. 

 To use the Clavicle Angle tool: 

When the tool is started the following message appears. 

  

1. Ensure that the selected image is oriented so that the left body side is on the left and the 
right body side is on the right. If it is not, click Flip Left/Right to flip the image accordingly 
and then OK. 

2. The tool appears on the image. You can drag the points to change the angle of the tool. 
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Coronal Balance 
This tool measures the alignment of the spine on the coronal plane. The horizontal distance 

between the midpoints of the C7 body to the center of the sacrum on an upright long cassette 

PA radiograph of the spine is measured and displayed. 

• When the tool is started the following message appears. 

 

• Ensure that the selected image is oriented so that the left body side is on the left and the 

right body side is on the right. If it is not, click Flip Left/Right to flip the image accordingly 

and then OK. 

The tool appears on the image, as shown below.  
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Sagittal Balance 
This tool measures the alignment of the spine on the sagittal plane. The horizontal distance 

between the midpoints of the C7 body to the posterior superior corner of the sacrum on an 

upright long cassette lateral radiograph of the spine is measured and displayed. 

• When the tool is started the following message appears. 

 

• Ensure that the selected image is oriented so that the posterior is on the left and the 

anterior is on the right. If it is not, click Flip Left/Right to flip the image accordingly and then 

OK. 
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Lumbar Lordosis Angle 
This tool measures the anterior convex angulation of the lumbar spine. The recommended 

measurement of lumbar lordosis from a lateral radiograph is the angle between the superior 

endplate of L-1 and the superior endplate of S-1. 
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Pelvic Radius Angle 
There are three different measurements that are used to describe pelvic morphology, based on 

sagittal plane radiographic measurements: 

• Sacral Slope (SS), which represents the angle between a line tangent to the sacral endplate 

and the horizontal reference line 

• Pelvic incidence (PI), represents the angle formed between the perpendicular to the 

tangent of the sacral endplate and a line connecting the center of the average hip joint and 

the center of sacral endplate 

• Pelvic tilt (PT), which represents the angle between a line connecting the center of the 

average hip joint and the center of sacral endplate to the vertical reference line 

The SS, PI and PT are very similar and are equally good methods to assess pelvic morphology. 

• When the tool is started the following message appears. 

 

• Ensure that the selected image is oriented so that the posterior is on the left and the 

anterior is on the right. If it is not, click Flip Left/Right to flip the image accordingly and then 

OK. 
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Sacral Obliquity 
This tool measures the angular deviation of the sacrum from the line drawn parallel to a line 

across the femoral heads on a supine AP view of the sacrum. 
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Spine Slip Angle 
This tool measures the angle that is formed by extending a line along the superior endplate of 

the body of L5 until it intersects with a line that is perpendicular to a line that is drawn along the 

posterior border of the body of first sacral vertebra. 
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Spondylolysthesis 
Spondylolysthesis is forward slippage of a vertebra onto the next vertebra below it. The most 

commonly used grading system for Spondylolysthesis is the one proposed by Meyerding 

in 1947. 

The degree of slippage is measured as the percentage of distance the anteriorly translated 

vertebral body has moved forward relative to the superior endplate of the vertebra below. 

Classifications use the following grading system: 

• Grade 0: No slippage 

• Grade 1: 1-25% slippage 

• Grade 2: 26-50% slippage 

• Grade 3: 51-75% slippage 

• Grade 4: 76-100% slippage 

• Grade 5: Greater than 100% slippage (spondyloptosis) 

 To use the Spondylolysthesis tool: 

1. When the tool is started the following message appears. 

 

2. Ensure that the selected image is oriented so that the posterior is on the left and the 

anterior is on the right. If it is not, click Flip Left/Right to flip the image accordingly and then 

OK. 

The tool appears on the image.  

3. You can drag the points to change the angle of the tool. 
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T1 Tilt Angle 
This tool measures the angle between a line along the cephaled endplate of T1 to a line 

perpendicular to the vertical edge of the radiograph. 
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Thoracic Kyphosis Angle 
This tool measures the posterior convex angulation of the thoracic spine. The recommended 

measurement of thoracic Kyphosis from a lateral radiograph is the angle between the superior 

endplate of the highest measurable thoracic vertebra, usually T-2 or T-3, and the inferior 

endplate of T-12. 
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Thoracic Trunk Shift 
This tool measures the trunk shift from the center of a line at the height of the apical thoracic 

vertebra to the central sacral vertebral line. 
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FOOT AND ANKLE MEASUREMENTS 

The following foot and ankle measurements can be made using TraumaCad measurements 

tools: 

• Foot Osteotomies Wizard, page 150 

• Hallux Valgus Angle, page 154 

• Hallux Valgus Interphalangeus Angle, page 155 

• Intermetatarsal Angle, page 156 

• DMAA - Distal Metatarsal Articular Angle, page 157 

• PMAA - Proximal Metatarsal Articular Angle, page 158 

• Talar Tilt, page 159 
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Foot Osteotomies Wizard 
The Foot Osteotomies Wizard enables orthopedic surgeons to take unilateral or bilateral 

anatomical measurements, compare them to normative standards and to simulate corrective 

procedures. Easy-to-use wizards help surgeons produce a wide range of anatomical 

measurements. Measurements and evaluations integrate into patient files for an easy transition 

to digital radiology. 

 To use the Foot Osteotomies wizard: 

1. Specify whether you want to measure unilaterally or bilaterally by selecting the appropriate 
option. 

 

The steps shown below are those that appear in the wizard when you select Unilateral. For 

the Bilateral option, these same steps are performed on both feet. 

2. Follow the 14 steps in the wizard and mark the relevant points on the image corresponding 

to each step. 

 

The anatomical measurements are shown in the top-left corner of the Measurements tab. 
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The following measurements are calculated using the wizard: 

• Hallux Valgus Angle (HVA): The angle between the longitudinal axes of the metatarsus 

and proximal phalanx of the big toe. 

• Intermetatarsal Angle (IMA): The angle between the longitudinal axes of the first and 

second metatarsal bones. 

• Distal Metatarsal Articular Angle (DMAA): The complement angle to 90° for an angle 

between the longitudinal axis of the first metatarsus to its distal articular surface. 

• In the table, normal values appear green and abnormal values appear red. 

3. Select the Store preoperative measurements checkbox to store the associated 

measurements. 
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Foot Osteotomies Simulation 
After completing the foot deformity measurements, a simulation of osteotomies can be done. 

Be sure that you stored the measurements from the Foot Osteotomies Wizard before 

proceeding. 

For osteotomies, define the fragments using the Define Fragment tool, which is accessible from 

the toolbar and the menu bar. Double-click a fragment to cut the fragment. 

Then, choose the exact location of the osteotomy in the Location of Osteotomy window. This 

window appears automatically after you cut a fragment. 

 

The red circle that appears after completing the osteotomy is the axis of rotation of the 

fragment and should be placed manually on the medial or lateral cortex of the bone for the 

opening/closing wedge. 

Simulation of the osteotomies can now be done by rotating the yellow fragment handle or by 

clicking on the Ctrl key on the keyboard while moving the fragment. 

Now you can zoom in and measure the osteotomies’ parameters, such as length angle and so 

on. 

The projected post-operative measurements are displayed in a table in the Measurements tab.  
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Hallux Valgus Angle 
This tool measures the angle between the longitudinal axes of the metatarsus and the proximal 

phalanx of the big toe. 
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Hallux Valgus Interphalangeus Angle 
This measurement tool measures the angle between the longitudinal axes of the proximal 

phalanx and the distal phalanx of the big toe. 
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Intermetatarsal Angle 
This measurement tool measures the angle between the longitudinal axes of the first and 

second metatarsal bones. 
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DMAA - Distal Metatarsal Articular Angle 
This measurement tool measures the complement angle to 90° of an angle between the 

longitudinal axes of the first metatarsus to its distal articular surface. 
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PMAA - Proximal Metatarsal Articular Angle 
This measurement tool measures the complement angle to 90° of an angle between the 

longitudinal axes of the first metatarsus to its proximal articular surface. 
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Talar Tilt 
This tool measures the angle between the ankle articular surfaces of the tibia and talus. 
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UPPER LIMB MEASUREMENTS 

The following upper limb measurements can be made using TraumaCad measurements tools: 

• Center Line Finder, below 

• Simple Line, below 

• Joint Line, below 

Center Line Finder 
The tool appears on the image. This tool works as described in the Center Line Finder section on 

page 96. 

Simple Line 
The tool appears on the image. This tool works as described in the Simple Line section on 

page 97. 

Joint Line 
The tool appears on the image. This tool works as described in the Joint Line section on page 99. 
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CORA TOOLS 

Center Line Finder 
The tool appears on the image. This tool works as described in the Center Line Finder section on 

page 96. 

Joint Line 
The tool appears on the image. This tool works as described in the Joint Line section on page 99. 
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GROWTH CALCULATOR 

CDC Growth Charts 
The growth charts consist of a series of percentile curves that illustrate the distribution of 

selected body measurements in children in the United States.  

 To access the Growth Calculator: 

From the Measurement Tools menu, or the Pediatric Measurements tab, select Growth 
Calculator 

 

The Growth Calculator includes 11 tabs, each one provides different options for predicting 

the growth of a particular anatomy in pediatric orthopedics, as described below. You can 

navigate through the different tabs by using the arrow button on the right side of the tabs. 

Begin by entering descriptive information about the patient, such as the patient’s name, 

gender, date of birth and patient ID in the respective fields at the top of the window. Then, 

select the appropriate tab in the window, enter the required information and click Answer. 

The following buttons are available at the bottom of the window: 

Save to File: Saves Growth Calculator data to an *.XML file 

Load from File: Imports previously saved Growth Calculator data from an *.XML file 

Export to Excel: Saves Growth Calculator data to a *.CSV file 

About: Displays Growth Calculator version information 

Exit: Closes the Growth Calculator 



Measuring the Anatomy 

 163 

Height Prediction Page 
Purpose: Predicts the height of this patient at maturity. 

Formula: Predicted Height = Current Height x Height Multiplier (specific for age and sex, using a 

normal chart) 

Leg Length Prediction Page 
Purpose: Predicts leg length at maturity. 

Formula: Predicted length at maturity = Current Length x Multiplier (specific for age and sex, 

using a lower limb chart) 

Growth remaining = Current length - predicted length 

Arm Length Prediction Page 
Purpose: Predicts the length of an arm at maturity. 

Formula: Predicted length at maturity = Current Length x Multiplier (specific for age and sex) 

Growth remaining = Current length - predicted length 

Leg Length Discrepancy Prediction - Congenital Page 
Purpose: Predicts the leg length discrepancy at maturity for this patient with congenital LLD. 

(Congenital = congenital femoral deficiency, fibular hemimelia, tibial hemimelia, 

hemihypertrophy, hemiatrophy, posteromedial bow of tibia) 

Formula: Predicted length discrepancy at maturity = Current Length Discrepancy x Multiplier 

(specific for age and sex, using a lower limb chart) 

Leg Length Discrepancy Prediction - Developmental Page 
Purpose: Predicts the leg length discrepancy at maturity for this patient with developmental 

LLD. (Developmental = Ollier’s, polio, growth arrest, also works for congenital discrepancies 

after lengthening) 

Formulas: Predicted length discrepancy at maturity = current difference + [1- (short leg current - 

short leg previous)/ (long leg current - long leg previous)] x Long leg current (Multiplier (specific 

for age and sex using a lower limb chart) -1) 

Inhibition = 1- (short leg current - short leg previous)/ (long leg current - long leg previous) 

Arm Length Discrepancy Prediction - Congenital Page 
Purpose: Predicts arm length discrepancy at maturity for this patient with congenital LLD. 

(Congenital = hemihypertrophy, hemiatrophy) 

Formula: Predicted length discrepancy at maturity = Current Length Discrepancy x Multiplier 

(specific for age and sex, using an upper limb chart) 
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Arm Length Discrepancy Prediction - Developmental Page 
Purpose: Predicts arm length discrepancy at maturity for this patient with developmental LLD. 

(Developmental = Ollier’s, polio, growth arrest, also works for congenital discrepancies after 

lengthening) 

Formulas: Predicted length discrepancy at maturity = current difference + [1- (short arm 

current - short arm previous)/ (long arm current - long arm previous)] x Long arm current 

(Multiplier [specific for age and sex using upper limb chart] -1) 

Inhibition = 1- (short arm current - short arm previous)/ (long arm current - long arm previous) 

Timing of Epiphyseodesis at the Knee Page 
Purpose: Suggests the timing for epiphyseodesis around the knee of a long limb to equalize the 

limb length discrepancy at maturity. 

Formulas: Multiplier at correct age for epiphyseodesis = [current long leg length x current 

multiplier specific for age and sex using lower limb chart]/ (current long leg length x current 

multiplier specific for age and sex using lower limb chart) - desired correction / kappa 

Kappa should be calculated for three scenarios: distal femur = 0.71,  

Proximal tibia = 0.57, both distal femur and proximal tibia = 0.67. 

The resultant Multiplier at age correct for epiphyseodesis must be translated back to a 

chronologic age using the lower extremity Multiplier chart specific for age and sex. 

Timing of Stapling for Hemi-epiphyseodesis Page 
Purpose: Suggests the timing for hemi-epiphyseodesis around the knee to correct angular 

deformities, if the staple will not be removed. 

Formulas: Multiplier at correct age for hemi-epiphyseodesis = [current bone length x current 

multiplier specific for age and sex using lower limb chart] / ([current bone length x current 

multiplier specific for age and sex using lower limb chart] - [(width of the growth plate x desired 

correction/57) / kappa]. 

Kappa should be calculated for one of two scenarios: distal femur = 0.71, proximal tibia = 0.57. 

The resultant Multiplier at age correct for hemi-epiphyseodesis must be translated back to a 

chronologic age using the lower extremity Multiplier chart specific for age and sex. 

Timing of Staple Removal for Hemi-epiphyseodesis Page 
Purpose: Suggests the timing for removing a staple inserted for hemi-epiphyseodesis around the 

knee to correct angular deformities, assuming that the stapling was done well prior to skeletal 

maturity. 
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Formulas: Multiplier at correct age for removal of hemi-epiphyseodesis staple = [current bone 

length x current multiplier specific for age and sex using lower limb chart] / ([current bone leg 

length + [(width of the growth plate x desired correction/57)/ kappa] 

Kappa should be calculated for one of two scenarios: distal femur = 0.71, Proximal tibia = 0.57. 

The resultant Multiplier at age for removal of hemi-epiphyseodesis staple must be translated 

back to a chronologic age using the lower extremity Multiplier chart specific for age and sex. 
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3D TOOLS 

3D Angle 
The 3D Angle tool is used to determine the measurement of a 3D angle, including its two 

endpoints and vertex. This tool enables you to calculate the angle between any three points on 

the body of the patient. 

In the 3D procedure, select the Measurements tab to display the 3D Angle option: 

 

To set a point for the 3D angle, click its Select button and then click an image to set the point in 

that frame. The three points defining the 3D angle can be placed on different image frames, and 

do not have to be placed on a single image. Use the mouse wheel to scroll through the different 

frames of the same 3D image. When doing so, be sure to scroll before clicking a Select button. 

Repeat this process to set the other two points in the image. 

Click the Locate button to locate its associated point on an image frame. The associated point is 

shown in all views. The locate mechanism scrolls on all views to the frame where the point is 

located. The located point is always shown red. 

For each 3D angle, the measurement shows the value of the angle in the 3D volume, as well as 

its projected angle on that frame. The projection is the projected angle on a specific plane, 

meaning how the angle displays in the current frame view. For example, in the example below, 

the projection in the upper-right frame is almost identical to the actual 3D angle (in this case, 

92°). 
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When working in MPR mode, you can change the bottom-right view to an oblique one, which 

enables you to rotate the frame to show any plane in the 3D image volume. Click Align Oblique 

View to show the exact view that contains all three points of the 3D angle. Note that for the 

resulting oblique view, the actual angle and its projection have the same value, as they are both 

on the same plane. 
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You can define as many angles as needed. To do so, click the  button to show another angle 

on the same image, as shown below: 
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PREPARING REPORTS 
Once the planning is completed, you can go to the Report tab to preview the image that will be 

saved or committed back to the PACS system. TraumaCad HTML report includes the following 

information: patient details; Referring MD details; Surgery Information – institution and date; 

the selected implants information and any measurements taken; and the original and planned 

images.  

An example of an HTML report is shown below. It can be printed, committed to PACS, saved 

locally or uploaded to Quentry for future reference. 

 

Warning! Be sure to save the patient’s case in order not to lose patient data. See 

page 21 for details. 

 

Warning! The material generated by the program is two dimensional. Before 

performing a procedure, confirm that the actual bone matches the image produced 

by the software. 
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GENERATING REPORTS 

 To generate a report: 

1. Select the Report tab. The following is then displayed: 

 
The following options are provided: 

• Original Image: Specifies that the original images are included in the report. 

• Templated Image: Specifies that the images after templating are included in the report. 

• Surgery Information: Specifies the surgery institution and the date the surgery will be 

performed, and adds specific user comments to the report. 

• Show Report: Displays an HTML report. You should save this report or print it before 

opening another case study. 

• Print Report: Prints the report. 

• Preview: Previews the image to be stored, as shown below: 
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Note: the text annotation saved on the planned image can be customized.  
To change the data displayed on the image go File menu  Settings  Save Case. 
To change the font preferences go to File menu  Settings  Text. 

 

• Save Case: Saving a case enables you to store all its images, templates, measurements 

and case information and later reopen it in TraumaCad. This option opens a window in 

which you can select to save this case by choosing any of the following options: 

 Upload to Quentry. 

- Use JPEG Lossy Compression: When this option is selected, the DICOM files in the 

*.tcc file sent to Quentry are compressed using JPEG Lossy compression. 

 Commit to PACS. 

- Include the report while saving to PACS. 

 Save Locally: 

- Save locally in the My TraumaCad Cases folder. 

- Save to an external device drive that you select, such as a memory stick. 

 Select the location for the annotation on the image.
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APP. A - INSTALLING TRAUMACAD 
Installation of TraumaCad must be performed on a computer that is connected to the web. If a 

web connection is not available for a certain computer, an alternative activation can be 

completed using a license file. For additional information, contact Brainlab support. 

After installation and the first launch, TraumaCad does not need to be connected to the web. 

 

Note: For standalone versions of TraumaCad, the PACS configuration must first be set 

up in order to specify the connection properties between TraumaCad and the PACS 

system. Typically, this only needs to be performed once by a system administrator 

after the initial installation of TraumaCad. The system administrator should make 

sure to enter the relevant connection properties in the PACS system so that it 

recognizes TraumaCad. For more information, see page 177. 
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HOW TO INSTALL TRAUMACAD 

The TraumaCad installation program will check if Windows .Net is installed on your computer. If 

it is not, it will download and install it. You are then required to restart your computer.  

 To install TraumaCad: 

1. The License Agreement window is displayed. Read the agreement and click Accept. 

 

The following window is displayed: 
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When the following window is displayed, click Install. 

  

A progress window is displayed, showing the progress of the download: 

  

2. At the end of the installation process, the License Activation window is displayed: 

 

3. Enter a valid activation key and click Activate.  
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INSTALLING FROM THE WEB 

If you are installing via the web, launch Internet Explorer and then enter the URL of the 

organization’s server that runs TraumaCad Server. The following security warning is displayed: 

  

Click Install. A progress window is displayed, showing the progress of the download: 

 

At the end of the installation process, TraumaCad launches automatically.
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APP. B - STANDALONE USAGE 
This appendix describes several procedures that may be required in standalone mode, as 

follows: 

• Importing Images, page 36 

• Capturing Images From the Screen, page 37 

• Setting the PACS Configuration (Optional), page 177 
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SETTING THE PACS CONFIGURATION (OPTIONAL) 

 This optional step only applies to standalone versions of TraumaCad. It enables you to 

specify the connection properties between TraumaCad and the PACS system. Typically, this only 

needs to be performed once by a system administrator after the initial installation of 

TraumaCad. The system administrator should make sure to enter the relevant connection 

properties in the PACS system so that it recognizes TraumaCad. 

 

Note: Client/server versions of TraumaCad can skip this step since it is performed on 

the server, as described in the TraumaCad Administrator’s Guide. 

 To set up the PACS Configuration: 

1. In the menu bar, select File  PACS Configuration. The PACS Configuration window is 
displayed: 

 

2. Enter the relevant PACS connection information into the appropriate fields. This information 

should be available to your network administrator. 

3. Click OK to save to apply these settings. 
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APP. C - MANAGING IMPLANT 

TEMPLATES 
 

TraumaCad provides a large library of digital templates for a wide variety of orthopedic surgical 

procedures. 

   

For the client/server and TraumaCad Web versions of TraumaCad, these implant images are 

automatically imported and updated on your computer from the TraumaCad server.  

 

For the standalone version of TraumaCad, select File > Download Templates in the menu bar to 

download templates of implants from Brainlab’s global repository to your computer. 

Each implant is provided in a variety of sizes and properties and each such group is called an 

implant template. Several implanting scenarios can be recorded and compared to find the optimal 

implant procedure. Once an implant is chosen, it can easily be scaled and manipulated. 
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IMPORTING IMPLANT TEMPLATES 

Before TraumaCad is used for the first time, the implant templates should be imported. This 

procedure should also be performed from time to time to update the template library. 

 

TEMPLATES MANAGER 

After the Templates Downloader is launched, it assesses the locally stored templates and the 

latest templates on the Brainlab server. 

 

The Templates Downloader window lists the templates stored locally and those on Brainlab’s 

TraumaCad server. Each row in the table represents one implant template. Each row contains the 

following fields: 

• State: Displays the current state of the implant template on the TraumaCad client. The State is 

determined by comparing the TraumaCad client’s list of templates to the list stored on the 

TraumaCad server. 
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• Implant Name: The name of the implant template. 

• Manufacturer: The manufacturer of the implant template. 

• Procedure: The TraumaCad procedure for which the implant template can be used. 

• Classification: The implant template type, as defined on the TraumaCad server. 

• Version No.: The version number of the implant template on the TraumaCad server. 

• Last Modified: The date the implant template was last changed on the TraumaCad server. 

In the Select dropdown list, you can specify whether you want to choose all or some implant 

templates. Whichever option you select automatically checks the checkboxes of the corresponding 

implant templates in the table. The available options are: 

• New & Updated: Selects implant templates that are either new to or that have been updated 

on the TraumaCad server. This is the default. 

• New: Selects implant templates that exist on the TraumaCad server, but that do not exist on 

the local TraumaCad client. 

• Updated: Selects implant templates that have been updated on the TraumaCad server. A 

newer version of this template exists on the server. 

• Existing: Selects implant templates that currently exist on the TraumaCad client. This means 

that the latest version of the template already exists on the local client. 

• All: Selects all implant templates in the table. 

• None: Selects no implant templates in the table. 

You can also select a specific implant template(s) by selecting its respective checkbox in the Select 

column of the table. 

 To download templates to the local client: 

1. Select the required templates by clicking the checkbox to the left of the template name or by 

selecting the relevant option in the Select dropdown list. 

2. Click the  Download Selected Templates button to start downloading the selected 

templates. 
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Searching for Templates 
You can search for specific templates (meaning, filter the list of templates) by entering text, such 

as the template name or part of the name in the Filter area and clicking the  Search 

Templates button to its right. You should then select one of the options from the dropdown menu 

in the right field in the Filter area to specify whether this text appears anywhere in the template 

information, in the State column, Implant Name column, Manufacturer column, Procedure 

column, Classification column or Version No: column. 

 

Remove Selected Templates 
Select the required templates by clicking the checkbox to the left of the template name and then 

click the  Remove Selected Templates button to delete the implant template from the local 

TraumaCad client. 

Change Templates Folder 
By default, templates are stored locally in your drive (typically the C drive) under C:\Documents 

and Settings\All Users\Application Data\TraumaCad\Templates. To change the folder in which 

they are stored, click the  Change Templates Folders button to display the Browse For Folder 

window in which you can select a different location for template storage. 
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